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Preface CATIA Prismatic Machining enables you to define and manage NC programs dedicated to machining parts designed in 3D wireframe or solids geometry using 2.5 axis machining techniques. It offers an easy-to-use and easy-to-learn graphic interface that makes it suitable for shop floor-oriented use. Moreover, its leading edge technologies together with a tight integration with CATIA V5 design methodologies and DELMIA's digital manufacturing environment, fully satisfy the requirements of office programming. Thus, CATIA Prismatic Machining is a unique solution that reconciliates office and shop floor activities. It is integrated to a Post Processor Access execution engine, allowing the product to cover the whole manufacturing process from tool trajectory (APT source) to NC Data (ISO format). This product is particularly adapted for tooling and simple machined parts, and is also an ideal complement of other manufacturing applications. CATIA Prismatic Machining offers the following main functions: 2.5 axis milling and drilling capabilities Management of tools and tool catalogs Flexible management of the manufacturing program with intuitive and easy-to-learn user interface based on graphic dialog boxes Tight interaction between tool path definition, verification and generation Seamless NC data generation thanks to an integrated Post Processor Access solution Automatic shop floor documentation in HTML format High associative level of the manufacturing program ensures productive design change management thanks to the integration with CATIA V5 modeling capabilities Based on the Process Product Resources (PPR) model, the manufacturing applications are integrated with Digital Process for Manufacturing (DPM).



Certain portions of this product contain elements subject to copyright owned by the following entities: © Copyright LightWork Design Ltd., all rights reserved. © Copyright Deneb Robotics Inc., all rights reserved. © Copyright Cenit, all rights reserved. © Copyright Intelligent Manufacturing Software, all rights reserved.



What's New? Cutter Profile Output New: You can now obtain cutter profile output when generating APT or ISO code for Profile Contouring and Circular Milling operations. Pocketing Operations New: Dedicated options are now available for machining Open Pockets. Enhanced: You can now specify operation start and end points for helical machining. Enhanced: You can now constrain the tool to stay on the pocket bottom in transitions between domains of pocket. Facing Operations Enhanced: You can now specify operation start and end points for helical machining. Point to Point Operations Enhanced: You can now specify approach and retract macros on Point to Point operations. Axial Machining Operations Enhanced: You can now specify approach, retract and linking macros on all types of axial machining operations. User-defined Tool Representation New: You can now replace a catalog tool by a user-defined CATPart tool representation. Customizing Enhanced: Additional options in Tools > Options for NC Manufacturing. Attach Generated NC Output to Program New: You can now attach the generated NC file to the program and display it in text editor. Replay Enhanced: Visualization of cutter profile trajectory and user-defined tool representation.



Getting Started Before getting into the detailed instructions for using CATIA Prismatic Machining, this tutorial is intended to give you a feel of what you can accomplish with the product. It provides the following step-by-step scenario that shows you how to use some of the key functionalities. Entering the Workbench Create a Pocketing Operation Replay the Toolpath Create a Contouring Operation Create a Drilling Operation Assign a Macro Assign a Tool Generate NC Code



Entering the Workbench This first task shows you how to open a part and enter the Prismatic Machining workbench. 1. Select File -> Open then select the GettingStartedPrismaticMachining.CATPart document. 2. Select NC Manufacturing > Prismatic Machining from the Start menu. The Prismatic Machining workbench appears. The part is displayed in the Set Up Editor window along with the manufacturing specification tree.



3. Select Manufacturing Program.1 in the tree to make it the current entity. A program must be current before you can insert program entities such as machining operations, tools and auxiliary commands.



Create a Pocketing Operation This task shows you how to insert a pocketing operation in the program. As this operation will use the default tool and options proposed by the program, you just need to specify the geometry to be machined. 1. Select the Pocketing icon . A Pocketing.1 entity along with a default tool is added to the program.



The small



symbol on the Pocketing tree icon means that the operation definition is incomplete.



The Pocketing dialog box appears directly at the . Geometry tab page The red status light on the tab indicates that you must select the pocket geometry in order to create the operation. The Geometry page includes an icon representing a simple pocket. There are several sensitive areas and texts in the icon to help you specify the pocket geometry. Sensitive areas that are colored red indicate required geometry.



2.



Click the red Bottom area in the icon. The dialog box is reduced allowing you to select the corresponding part geometry.



3.



Select the bottom of the pocket. The boundary of the selected pocket bottom is proposed as drive element for the operation. The dialog box reappears. The bottom and sides of the pocket in the icon are now colored green, indicating that the corresponding geometry is defined for the operation. The tab status is . now green



4.



Click OK to create the operation.



Replay the Tool Path This task shows you how to replay the tool path of the pocketing operation. 1.



2.



3.



Select the pocketing operation in the tree then select the Replay Tool Path . icon The Replay dialog box appears. Choose the Point by Point replay mode by means of the drop down icon . You can set the number of points to be replayed at each step of the replay by means of the combo. Click the button to position the tool at the start point of the operation.



4.



Click the



button to start the replay



and continue to click that button to move the tool along the computed trajectory.



5.



Click OK to quit the replay mode.



Create a Profile Contouring Operation This task shows you how to insert a profile contouring operation in the program. Make sure that the pocketing operation is the current entity in the program. 1.



Select the Profile Contouring icon



.



The Profile Contouring dialog box appears directly at the Geometry page



.



2.



Click the Bottom: Hard text in the sensitive icon to switch the type of bottom to Soft.



3.



Click the Bottom plane then select the corresponding part geometry (that is, the underside of the part). The closed external contour of the bottom is proposed as Guide element for the operation.



4.



If needed, to set the tool axis orientation, double click the Tool Axis symbol then click the Reverse Direction button. Make sure that the arrow on the Guide element is pointing away from the part.



5. 6.



Click the Top plane in the icon, then select the corresponding part geometry. Double click Offset on Contour in the icon. Set this value to 1mm in the Edit Parameter dialog box and click OK.



7.



Select the Strategy tab page



and set the



parameters as shown.



8.



Click Preview in the dialog box to request that the program verifies the parameters that you have specified.



9.



A message box appears giving feedback about this verification. Click Replay in the dialog box to visually check the operation's tool path.



10.



Click OK to create the operation.



Create a Drilling Operation This task shows you how to insert a drilling operation in the program. 1. Select the Drilling icon



.



The Drilling dialog box appears directly at the Geometry page The program is updated to include a Drilling operation. The Drilling dialog box appears.



2. Select the red hole depth representation in the sensitive icon. The Manufacturing View dialog box appears to help you specify the pattern of holes to be machined. 3. Select the cylindrical feature of the first hole. 4. Select the second hole feature, then double click to end hole selection. The Drilling dialog box replaces the Manufacturing View dialog box. The icon is updated with geometric information about the first selected hole of the pattern.



.



5. Double click the Jump distance parameter in the sensitive icon, then enter a value of 5mm in the Edit Parameter dialog box. 6. Click Replay to replay the operation as described previously. Click OK to return to the Drilling dialog box. 7. Click OK to create the Drilling operation in the program.



Assign a Macro This task shows you how to assign a circular approach macro to the Profile Contouring operation. 1.



Double click the Profile Contouring operation in the program, then select the Macro tab page .



2.



Click the Approach checkbox.



3.



Click the Circular Approach icon. The icon representing the approach motion is displayed. Default values are displayed on the individual paths of the macro.



4.



Double click the circular path of the macro. A dialog box appears allowing you to specify the desired parameters of the circular path.



5.



Enter values in the dialog box as shown and click OK.



6.



Click Replay in the Profile Contouring dialog box to verify the approach motion. Click OK to return to the Profile Contouring dialog box.



7.



Click OK to assign the specified macro to the operation.



Assign a Tool This task shows you how to assign another tool to an operation. 1.



Double click the Profile Contouring operation in the program, then select the Tool tab page



.



2. Enter a name of the new tool (for example, 16mm Flat Milling Tool). 3. Double click the D (nominal diameter) parameter in the icon, then enter 16mm in the Edit Parameter dialog box. The tool icon is updated to take the new value into account.



4. Double click the Rc (corner radius) parameter in the icon, then enter 0mm in the Edit Parameter dialog box. Set the db (body diameter) parameter to 24mm in the same way.



The Tool number is set to 2.



5. Click OK to accept the new tool. The program is automatically updated. You can modify the tools of the other operations in the same way. For example, you may want to replace the End Mill by a Drill in the Drilling operation.



Generate NC Code This task shows you how to generate the NC code from the program. 1.



Use the right mouse key on the Manufacturing Program.1 entity in the tree to select Generate NC Code Interactively. The Save NC File dialog box appears.



2.



Select the folder where you want the file to be saved and specify the name of the file.



3.



Click Save to create the APT file. Here is an extract from the Apt source file that will be generated: $$ ----------------------------------------------------------------$$ Generated on Tue May 23 15:20:47 2000 $$ ----------------------------------------------------------------$$ Manufacturing Program.1 $$ Part Operation.1 $$*CATIA0 $$ Manufacturing Program.1 $$ 1.00000 0.00000 0.00000 0.00000 $$ 0.00000 1.00000 0.00000 0.00000 $$ 0.00000 0.00000 1.00000 0.00000 PARTNO PART TO BE MACHINED COOLNT/ON CUTCOM/OFF PPRINT OPERATION NAME : Tool Change.1 $$ Start generation of : Tool Change.1 PPRINT TOOL = T1 End Mill D 10 CUTTER/ 10.000000, 2.000000, 3.000000, 2.000000, 0.000000,$ 0.000000,100.000000 TOOLNO/1, 10.000000 TPRINT/T1 End Mill D 10 LOADTL/1 TLAXIS/ 0.000000, 0.000000, 1.000000 RAPID GOTO/ 0.00000, 0.00000, 100.00000 $$ End of generation of : Tool Change.1 PPRINT OPERATION NAME : Pocketing.1 $$ Start generation of : Pocketing.1 FEDRAT/ 1000.0000,MMPM SPINDL/ 70.0000,RPM,CLW GOTO/ 35.36644, 2.50000, 5.00000 GOTO/ 42.50000, 2.50000, 5.00000 ... GOTO/ -15.00000, 35.00000, 5.00000 GOTO/ 35.61644, 35.00000, 5.00000 $$ End of generation of : Pocketing.1 PPRINT OPERATION NAME : Tool Change.2 $$ Start generation of : Tool Change.2 PPRINT TOOL = 16mm Flat Milling Tool CUTTER/ 16.000000, 0.000000, 8.000000, 0.000000, 0.000000,$ 0.000000,100.000000 TOOLNO/2, 16.000000



TPRINT/16mm Flat Milling Tool LOADTL/2 RAPID GOTO/ 0.00000, 0.00000, 100.00000 $$ End of generation of : Tool Change.2 PPRINT OPERATION NAME : Profile Contouring.1 $$ Start generation of : Profile Contouring.1 FEDRAT/ 300.0000,MMPM SPINDL/ 70.0000,RPM,CLW GOTO/ -69.00000, 40.00000, 46.00000 ... GOTO/ -69.00000, 50.00000, 16.00000 FEDRAT/ 1000.0000,MMPM GOTO/ -68.67819, 53.48215, 16.00000 GOTO/ -67.72364, 56.84635, 16.00000 ... GOTO/ -68.92036, -51.73784, 0.00000 GOTO/ -69.00000, 50.00000, 0.00000 $$ End of generation of : Profile Contouring.1 PPRINT OPERATION NAME : Tool Change.3 $$ Start generation of : Tool Change.3 PPRINT TOOL = 9mm Drill CUTTER/ 10.000000, 0.000000, 5.000000, 2.886751, 30.000000,$ 0.000000,100.000000 TOOLNO/3, 10.000000 TPRINT/9mm Drill LOADTL/3 RAPID GOTO/ 0.00000, 0.00000, 100.00000 $$ End of generation of : Tool Change.3 PPRINT OPERATION NAME : Drilling.1 $$ Start generation of : Drilling.1 LOADTL/3,1 SPINDL/ 70.0000,RPM,CLW RAPID GOTO/ -40.00000, 30.00000, 25.00000 CYCLE/DRILL, 10.000000, 1.000000, 1000.000000,MMPM GOTO/ -40.00000, 30.00000, 20.00000 GOTO/ -40.00000, -30.00000, 20.00000 CYCLE/OFF $$ End of generation of : Drilling.1 SPINDL/OFF REWIND/0 END



Basic Tasks The basic tasks you will perform in the Prismatic Machining workbench involve creating, editing and managing machining operations and other entities of the CATIA manufacturing process. Milling Operations Axial Machining Operations Auxiliary Operations Part Operation and Manufacturing Program Managing Manufacturing Entities Verification, Simulation and Program Output



Milling Operations The tasks in this section show you how to create milling operations in your manufacturing program. Create a Pocketing Operation: Select the Pocketing icon then select the geometry of the pocket to be machined and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed. A Pocketing operation can be created for machining: Closed pockets Tool machines the area delimited by hard boundaries Open pockets Tool machines the area that has a least one soft boundary. Create a Facing Operation: Select the Facing icon then select the geometry to be machined and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed. Create a Profile Contouring Operation: Select the Profile Contouring icon then select the geometry to be machined and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed. A Profile Contouring operation can be created for machining: Between two planes Tool follows contour between top and bottom planes while respecting user-defined geometry limitations and machining strategy parameters. Between two curves Tool follows trajectory defined by top and bottom guide curves while respecting user-defined geometry limitations and machining strategy parameters. Between a curve and surfaces Tool follows trajectory defined by a top guide curve and bottom surfaces while respecting user-defined geometry limitations and machining strategy parameters. Create a Point to Point Operation: Select the Point to Point icon then select the geometry to be machined and specify the tool to be used. Specify machining parameters and feeds and speeds as needed.



Create a Pocketing Operation for Machining Closed Pockets This task shows how to insert a Pocketing operation in the program when the pocket to be machined comprises hard boundaries only (that is, a closed pocket). To create the operation you must define: the Pocketing mode as Closed Pocket the geometry of the pocket to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the PrismaticMilling01.CATPart document, then select NC Manufacturing > Prismatic Machining from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Pocketing icon . A Pocketing entity along with a default tool is added to the program. The Pocketing dialog box appears directly at the . Geometry tab page This tab page includes a sensitive icon to help you specify the geometry to be machined.



The bottom and flanks of the icon are colored red indicating that this geometry is required for defining the pocket. All other pocket geometry is optional. Make sure that the Pocketing mode is set to Closed Pocket. 2.



Click the red Bottom in the icon then select the desired pocket bottom in the 3D window. The pocket boundary is automatically deduced by the program. This is indicated by the highlighted Drive elements.



The bottom and flanks of the icon are now colored green indicating that this geometry is now defined.



3.



Click the Top Plane in the icon then select the desired top element in the 3D window.



4.



Set the following offsets: 1.5mm on boundary 0.25mm on bottom. You can select an inner point and a border point as preferential start and end positions for the operation. This allows better control for optimizing the program according to the previous and following operations. Select the Strategy tab page to specify:



5.



tool path style radial strategy parameters axial strategy parameters. You can use the More button to specify additional parameters such as: machining tolerance thickness values for pocket finishing high speed milling parameters.



For a pocket with several domains, you can select Always stay on bottom to avoid unnecessary linking transitions. This option forces the tool to remain in contact with the pocket bottom when moving from one domain to another. In this case, you can also select Inward/outward mix to authorize changing from one toolpath style from one pocket domain to another. A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use. This is described in Edit the Tool of an Operation. 6.



Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



7.



Select the Macros tab page



to specify the



operation's transition paths (approach and retract motion, for example). Select the Approach and Retract checkboxes Select an Approach macro icon to specify the desired type of approach motion (linear, for example). A sensitive icon appears with a representation of the macro. Double click the distance parameter in the sensitive icon and enter the desired value in the pop-up dialog box. Repeat this procedure to specify the Retract motion. See Define Macros of an Operation for another example of specifying transition paths on a machining operation.



Before accepting the operation, you should check its validity by replaying the tool path.



8.



Click OK to create the operation.



Create a Pocketing Operation for Machining Open Pockets This task shows how to insert a Pocketing operation in the program when the pocket to be machined comprises at least one soft boundary (that is, an open pocket). To create the operation you must define: the Pocketing mode as Open Pocket the geometry of the pocket to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the PrismaticMilling02.CATPart document, then select NC Manufacturing > Prismatic Machining from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Pocketing icon . A Pocketing entity along with a default tool is added to the program. The Pocketing dialog box appears directly at the . Geometry tab page This tab page includes a sensitive icon to help you specify the geometry to be machined.



The bottom and flanks of the icon are colored red indicating that this geometry is required for defining the pocket. All other pocket geometry is optional. Make sure that the Pocketing mode is set to Open Pocket. 2.



Click the red Bottom in the icon then select the desired pocket bottom in the 3D window. The pocket boundary is automatically deduced by the program. This is indicated by the highlighted Drive elements. Hard boundaries are shown by full lines and soft boundaries by dashed lines. For edge selection only, you can change a boundary segment from hard to soft (or from soft to hard) by selecting the corresponding edge.



The bottom and flanks of the icon are now colored green indicating that this geometry is now defined.



3.



Click the Top Plane in the icon then select the desired top element in the 3D window.



4.



Set the following offsets: 1.5mm on boundary 0.25mm on bottom. You can select an inner point and a border point as preferential start and end positions for the operation. This allows better control for optimizing the program according to the previous and following operations. Select the Strategy tab page to specify:



5.



tool path style radial strategy parameters axial strategy parameters. You can use the More button to specify additional parameters such as: machining tolerance thickness values for pocket finishing high speed milling parameters.



For a pocket with several domains, you can select Always stay on bottom to avoid unnecessary linking transitions. This option forces the tool to remain in contact with the pocket bottom when moving from one domain to another. In this case, you can also select Inward/outward mix to authorize changing from one toolpath style from one pocket domain to another. A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use. This is described in Edit the Tool of an Operation. 6.



Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



7.



Select the Macros tab page



to specify the



operation's transition paths (approach and retract motion, for example). Select the Approach and Retract checkboxes Select an Approach macro icon to specify the desired type of approach motion (linear, for example). A sensitive icon appears with a representation of the macro. Double click the distance parameter in the sensitive icon and enter the desired value in the pop-up dialog box. Repeat this procedure to specify the Retract motion. See Define Macros of an Operation for another example of specifying transition paths on a machining operation.



Before accepting the operation, you should check its validity by replaying the tool path.



8.



Click OK to create the operation.



Create a Facing Operation This task shows how to insert a Facing operation in the program. To create the operation you must define: the geometry to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the PrismaticMilling01.CATPart document, then select NC Manufacturing > Prismatic Machining from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Facing icon . A Facing entity along with a default tool is added to the program. The Facing dialog box appears directly at the . Geometry tab page



2.



3.



This tab page includes a sensitive icon to help you specify the geometry to be machined. The part bottom and flanks in the icon are colored red indicating that this geometry is required for defining the operation. All other geometry is optional. Click the red Bottom in the icon then select the underside of the part in the 3D window. The part boundary is automatically deduced by the program. This is indicated by the highlighted Drive elements. The bottom and flanks of the icon are now colored green indicating that this geometry is now defined. You can select start and end points as preferential start and end positions on the operation. This allows better control for optimizing the program according to the previous and following operations. Select the Strategy tab page to specify: toolpath style radial strategy parameters. You can use the More button to specify additional parameters such as: machining tolerance thickness values for finishing axial strategy parameters high speed milling parameters.



4.



Select the Tool tab page



5.



Select the Face Mill icon.



to replace the default tool by a more suitable one.



A 50mm diameter face mill is proposed. You can adjust the parameters as required. See Edit the Tool of an Operation for more information about selecting tools. 6.



Select the Feeds and Speeds tab page



7.



Select the Macros tab page



to specify the feedrates and spindle speeds for the operation.



to specify a



return macro, which is necessary for the One Way mode. Select the Return in a Level checkbox. Select one of the macro icons to specify the desired type of approach motion (linear, for example). A sensitive icon appears with a representation of the path. Double click the distance parameter in the sensitive icon and enter the desired value in the pop-up dialog box. Repeat this procedure to specify the retract motion. See Define Macros of an Operation for another example of specifying transition paths on a machining operation.



Before accepting the operation, you should check its validity by replaying the tool path.



8.



Click OK to create the operation.



In this scenario the operation used the default starting point (that is, the origin of the absolute axis system). If you want to define a different starting point, you can click the starting point symbol in the sensitive icon then select a point. Please note that the exact position of operation's starting point may be different from your selected point. The program will choose the nearest point from a number of possible starting positions.



Create a Profile Contouring Operation Between Two Planes This task shows how to insert a 'Between Two Planes' Profile Contouring operation in the program. To create the operation you must define: the Contouring mode as Between two planes the geometry to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the PrismaticMilling01.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Profile Contouring icon . The Profile Contouring dialog box appears directly at the Geometry tab page . This page includes a sensitive icon to help you specify the geometry to be machined.



2. 3. 4. 5.



6.



7.



Right click the Contouring mode text and select Between Two Planes. The part bottom and flanks in the icon are colored red indicating that this geometry is required for defining the operation. All other geometry is optional. Click the red bottom in the icon, then select the underside of the part in the 3D window. Set the Bottom type to Soft by clicking the text, then set the Offset on Bottom to -5mm. Click the red flank in the icon, then select the profile along the front edge of the part in the 3D window. Click the First Limit in the icon, then select the horizontal edge at one end of the contour profile in the 3D window. Click the Second Limit in the icon, then select the horizontal edge at the other end of the contour profile in the 3D window. Click the check element in the icon, then select the top face of the green fixture in the 3D window. The bottom, guide, limit and check elements of the icon are now colored green indicating that this geometry is now defined. These are also indicated on the part.



8.



Select the Strategy tab page



to specify the



parameters of the machining strategy as follows: One way tool path style Radial strategy: number of paths = 1 Axial strategy: number of levels = 1. You can use the More button to access additional parameters such as machining tolerance and thickness values for finishing. You can choose between the standard tip output and a cutter profile output by means of the Output style option. If a cutter profile style is selected, both the tip and cutter profile will be visualized during tool path replay. The cutter profile output allows easier tool compensation to be done on the shop floor. A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use. This is described in Edit the Tool of an Operation. 9.



Select the Feeds and Speeds tab page



10.



Check the validity of the operation by replaying the tool path.



to specify the feedrates and spindle speeds for the operation.



The specified operation uses a default linking macro to avoid collision with the selected fixture. You can optimize the linking macro and add approach and retract macros to the operation in the Macros tab page . This is described in Define Macros of a Milling Operation. 11.



Click OK to create the operation.



Create a Profile Contouring Operation Between Two Curves This task shows how to insert a 'Between Two Curves' Profile Contouring operation in the program. To create the operation you must define: the Contouring mode as Between Two Curves the geometry to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the PrismaticMilling02.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Profile Contouring icon . The Profile Contouring dialog box appears directly at the Geometry tab page . This page includes a sensitive icon to help you specify the geometry to be machined.



2. 3. 4. 5.



6.



Right click the Contouring mode text and select Between Two Curves. The top guiding curve in the icon is colored red indicating that this geometry is required for defining the operation. All other geometry is optional. Click the top guiding curve in the icon, then select the top edge of the part in the 3D window. If needed, set offsets on the geometric elements. Click the bottom guiding curve in the icon, then select bottom edge of the part in the 3D window. Click the first relimiting element in the icon, then select a vertical edge at one end of the part in the 3D window. Click the second relimiting element in the icon, then select the vertical edge at the other end of the contour profile in the 3D window. The guide and limit elements of the icon are now colored green indicating that this geometry is now defined. These are also indicated on the part.



7.



Select the Strategy tab page



to specify the



parameters of the machining strategy as follows: Zig Zag tool path style Radial strategy: number of paths = 1 Axial strategy: number of levels = 3. You can use the More button to access additional parameters such as machining tolerance and thickness values for finishing. A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use. This is described in Edit the Tool of an Operation. 8.



Select the Feeds and Speeds tab page



9.



Check the validity of the operation by replaying the tool path.



to specify the feedrates and spindle speeds for the operation.



You can add approach and retract motions to the operation in the Macros tab page 10.



Define Macros of an Operation. Click OK to create the operation.



. This is described in



Create a Profile Contouring Operation Between a Curve and Surfaces This task shows how to insert a 'Between Curve and Surfaces' Profile Contouring operation in the program. To create the operation you must define: the Contouring mode as Between Curve and Surfaces the geometry to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the the PrismaticMilling02.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Profile Contouring icon . The Profile Contouring dialog box appears directly at the Geometry tab page . This page includes a sensitive icon to help you specify the geometry to be machined.



2. 3. 4. 5.



6.



Right click the Contouring mode text and select Between Curve and Surfaces. The top guiding curve and part bottom in the icon are colored red indicating that this geometry is required for defining the operation. All other geometry is optional. Click the red bottom in the icon, then select the bottom surface of the part in the 3D window. If needed, set offsets on the geometric elements. Click the top guiding curve in the icon, then select the top edge of the part in the 3D window. Click the first relimiting element in the icon, then select a vertical edge at one end of the part in the 3D window. Click the second relimiting element in the icon, then select the vertical edge at the other end of the contour profile in the 3D window. The guide and limit elements of the icon are now colored green indicating that this geometry is now defined. These are also indicated on the part.



7.



Select the Strategy tab page



to specify



the parameters of the machining strategy as follows: Zig Zag tool path style Radial strategy: number of paths = 3 Axial strategy: number of levels = 3. You can use the More button to access additional parameters such as machining tolerance and thickness values for finishing. A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use. This is described in Edit the Tool of an Operation. 8.



Select the Feeds and Speeds tab page



9.



Check the validity of the operation by replaying the tool path.



to specify the feedrates and spindle speeds for the operation.



You can add approach and retract motions to the operation in the Macros tab page Define Macros of an Operation. 10. Click OK to create the operation.



. This is described in



Create a Point to Point Operation This task shows how to insert a Point to Point operation in the program. To create the operation you must define: the geometry to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the PrismaticMilling01.CATPart document, then select NC Manufacturing > Prismatic Machining from the Start menu. Make the Manufacturing Program current in the specification tree. 1.



Select the Point to Point icon



.



A Point to Point entity along with a default tool is added to the program. The Point to Point dialog box appears directly at the Geometry tab page . This page includes a sensitive icon representing a simple point-to-point tool path.



2.



Click the red point-to-point tool path representation, then select the desired points to be machined in the 3D window. You can select the edges of the holes on the underside of the part. Just double-click to end point selection.



By selecting a circle, its center is taken as the point to machine. Points of an associated sketch could also have been selected. Points can be inserted or removed by means of the contextual menu.



3.



If needed, double click the sensitive text in the icon to specify an offset.



4.



Define the tool axis direction by first selecting the axis representation in the sensitive icon then specifying the direction in the dialog box that appears.



5.



Select the Strategy tab page



6.



Note that only Tool compensation is available for this operation. Select the Tool tab page to replace the default tool by a more suitable one.



7.



Select the Face Mill icon.



to specify machining parameters.



A 50mm diameter face mill is proposed. You can adjust the parameters as required. See Edit the Tool of an Operation for more information about selecting tools. 8.



Select the Feeds and Speeds tab page



9.



operation. If you want to specify approach and retract motion for the operation, select the Macros tab page



to specify the feedrates and spindle speeds for the



specify the desired transition paths. The general procedure for this is described in Define Macros of an Operation. Before accepting the operation, you should check its validity by replaying the tool path.



10.



Click OK to create the operation. You can use the contextual menu commands to insert or remove points and to assign local feedrates.



to



Axial Machining Operations The tasks in this section show you how to create axial machining operations in your manufacturing program.



Spot Drilling Operation Create a Spot Drilling Operation: Select the Spot Drilling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



Drilling Operations Create a Drilling Operation: Select the Drilling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Drilling Dwell Delay Operation: Select the Drilling Dwell Delay icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Drilling Deep Hole Operation: Select the Drilling Deep Hole icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Drilling Break Chips Operation: Select the Drilling Break Chips icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



Hole Finishing Operations Create a Reaming Operation: Select the Reaming icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Counterboring Operation: Select the Counterboring icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



Boring Operations Create a Boring Operation: Select the Boring icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Boring Spindle Stop Operation: Select the Boring Spindle Stop icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Boring and Chamfering Operation: Select the Boring and Chamfering icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Back Boring Operation: Select the Back Boring icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



Threading Operations Create a Tapping Operation: Select the Tapping icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Reverse Threading Operation: Select the Reverse Threading icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Thread without Tap Head Operation: Select the Thread without Tap Head icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



Countersinking and Chamfering Operations Create a Countersinking Operation: Select the Countersinking icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



Create a Chamfering Two Sides Operation: Select the Chamfering Two Sides icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.



T-Slotting and Circular Milling Create a T-Slotting Operation: Select the T-Slotting icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed. Create a Circular Milling Operation: Select the Circular Milling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros, and feeds and speeds as needed.



Create a Spot Drilling Operation This task shows how to insert a Spot Drilling operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Spot Drilling icon



.



A Spot Drilling entity along with a default tool is added to the program. The Spot Drilling dialog box appears directly at the Geometry tab page representing a simple hole. There are several hot spots in the icon. 2. Select red hole depth representation, then select the points to be spot drilled. You can do this by selecting the circular REDGEs of holes. In this case, the circle centers are taken as the points to be spot drilled. Just double click to end your selections.



3. If needed select a tool axis direction.



. This tab page includes an icon



4. Select the Strategy tab page



to specify the



following machining parameters: approach clearance depth mode: by diameter The diameter value used is the one specified in the geometry tab page. dwell compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Dwell for the specified duration Retract at retract feedrate from 2 to 3. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Spot Drilling operations: CYCLE / SPDRL, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/SPDRL, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Drilling Operation This task shows how to insert a Drilling operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Drilling icon



.



A Drilling entity along with a default tool is added to the program. The Drilling dialog box appears directly at the Geometry tab page



. This tab page includes a sensitive



icon to help you specify the geometry of the hole or hole pattern to be machined. 2. Select the red hole depth representation then select 4 hole features as shown below. Just double click to end your selections. The sensitive icon is updated with the following information: depth and diameter of the first selected feature hole extension type: through hole number of points to machine.



3. If needed, you can define the tool axis direction by first selecting the axis representation in the sensitive icon then specifying the direction by means of the dialog box that appears. 4. If needed, you can define a clearance by first double clicking the Jump Distance in the sensitive icon then specifying a value in the Edit Parameter dialog box that appears.



Note that the jump distance allows an extra clearance for moving in Rapid motion between the holes to be drilled whenever this distance is greater than the approach clearance. For example, for an approach clearance of 2.5mm and a jump distance of 10mm, the extra clearance is 7.5mm. You can also locally specify entry and exit distances at individual points in a hole pattern using the contextual menu (right click the pattern point). The contextual menu also allows you to skip pattern points and choose the start point for the pattern. 5. Select the Strategy tab page to specify the following machining parameters: Approach clearance Depth mode: by tip The depth value used is the one used in the Geometry tab page. Breakthrough distance Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



Remember that you can make use of the hole diameter found on the selected hole feature to select an appropriate tool. This is described in Edit the Tool of an Operation. 6. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the Drilling tool path represented in the strategy page, tool motion is as follows: machining feedrate from 1 to 2 retract or rapid feedrate from 2 to 3. 7. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 8. Click OK to create the operation.



to



Example of output If your PP table is customized with the following statement for Drilling operations: CYCLE/DRILL, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP A typical NC data output is as follows: CYCLE/DRILL, 38.500000, 500.000000, MMPM, 2.500000 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Drilling Dwell Delay Operation This task shows how to insert a Drilling Dwell Delay operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Drilling Dwell Delay icon . A Drilling Dwell Delay entity along with a default tool is added to the program. The Drilling Dwell Delay dialog box appears directly at the Geometry tab page



. This tab page includes



a sensitive icon to help you specify the geometry of the hole or hole pattern to drill. 2. Select the red hole depth representation then select the hole feature as shown. Just double click to end your selection.



The sensitive icon is updated with the following information: depth and diameter of the selected hole hole extension type: blind.



3. If needed, you can define the tool axis direction by first selecting the axis representation in the sensitive icon then specifying the direction by means of the dialog box that appears.



4. Select the Strategy tab page



to specify



the following machining strategy parameters: Approach clearance Depth mode: by shoulder The depth value used is the one specified in the Geometry tab page. Dwell delay Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



Remember that you can make use of the hole diameter found on the selected hole feature to select an appropriate tool. This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



6



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: machining feedrate from 1 to 2 dwell for the specified duration retract or rapid feedrate from 2 to 3. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path.



7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Drilling Dwell Delay operations: CYCLE / DRILL, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/DRILL, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Drilling Deep Hole Operation This task shows how to insert a Drilling Deep Hole operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Drilling Deep Hole icon



.



A Drilling Deep Hole entity along with a default tool is added to the program. The Drilling Deep Hole dialog box appears directly at the Geometry tab page



. This tab page includes a



sensitive icon to help you specify the geometry of the hole or hole pattern to be machined. 2. Select the red hole depth representation then select the hole features as shown below. Just double click to end your selections.



The sensitive icon is updated with the following information: depth and diameter of the first selected hole hole extension type: through number of points to machine. 3. If needed, you can define the tool axis direction by first selecting the axis representation in the sensitive icon then specifying the direction by means of the dialog box that appears.



4. Select the Strategy tab page



to specify the following



machining parameters: Approach clearance Depth mode: by tip The depth value used is the one specified in the Geometry tab page. Breakthrough distance Maximum depth of cut and retract offset Decrement rate and limit Dwell Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



Remember that you can make use of the hole diameter found on the selected hole feature to select an appropriate tool. This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Dwell for specified duration Retract at retract feedrate from 2 to 3 Motion at rapid rate from 3 to 4 Motion at machining feedrate from 4 to 5 Dwell for specified duration Retract at retract feedrate from 5 to 6 Motion at rapid rate from 6 to 7 Motion at machining feedrate from 7 to 8 Dwell for specified duration Retract at retract feedrate from 8 to 9 Distance (1,2) = A + Dc Distance (3,4) = A + Dc - Or Distance (4,5) = Or + Dc*(1 - decrement rate) Distance (7,8) = Or + Dc*(1 - 2*decrement rate).



6. If you want to specify approach and retract motion for the operation, select the Macros tab page



to



specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Drilling Deep Hole operations: CYCLE/DEEPHL,%MFG_TOTAL_DEPTH,INCR,%MFG_AXIAL_DEPTH,%MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT,%MFG_CLEAR_TIP,DWELL,%MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/DEEPHL, 25.000000, INCR, 5.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Drilling Break Chips Operation This task shows how to insert a Drilling Break Chips operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Drilling Break Chips icon



.



A Drilling Break Chips entity along with a default tool is added to the program. The Drilling Break Chips dialog box appears directly at the Geometry tab page



. This tab page includes a



sensitive icon to help you specify the geometry of the hole or hole pattern to be machined. 2. Select the red hole depth representation then select the hole feature as shown below. Just double click to end your selections.



The sensitive icon is updated with the following information: depth and diameter of the selected hole hole extension type: through. 3. If needed, you can define the tool axis direction by first selecting the axis representation in the sensitive icon then specifying the direction by means of the dialog box that appears.



4. Select the Strategy tab page



to specify the following



machining parameters. Approach clearance Depth mode: by tip The depth value used is the one specified in the geometry tab page. Breakthrough distance Maximum depth of cut and retract offset Dwell Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



Remember that you can make use of the hole diameter found on the selected hole feature to select an appropriate tool. This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Dwell for specified duration Retract at retract feedrate from 2 to 3 Motion at machining feedrate from 3 to 4 Dwell for specified duration Retract at retract feedrate from 4 to 5 Motion at machining feedrate from 5 to 6 Dwell for specified duration Retract at retract feedrate from 6 to 7 Distance (1,2) = A + Dc Distance (2,3) = Distance (4,5) = Or Distance (3,4) = Distance (5,6) = Or + Dc 6. If you want to specify approach and retract motion for the operation, select the Macros tab page desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation.



to specify the



Example of output If your PP table is customized with the following statement for Drilling Break Chips operations: CYCLE/BRKCHP,%MFG_TOTAL_DEPTH,INCR,%MFG_AXIAL_DEPTH,%MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP,DWELL,%MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/BRKCHP, 25.000000, INCR, 5.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Reaming Operation This task shows how to insert a Reaming operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Reaming icon



.



A Reaming entity along with a default tool is added to the program. The Reaming dialog box appears directly at the Geometry tab page . This tab page includes a sensitive icon to help you specify the geometry of the hole or hole pattern to be machined. 2. Select the red hole depth representation then select the desired hole features. Just double click to end your selections. The sensitive icon is updated with the following information: depth and diameter of the first selected feature hole extension type: through hole number of points to machine. 3. If needed, select the tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters. Approach clearance Depth mode: by shoulder The depth value used is the one specified in the Geometry tab page. Dwell (in seconds) Compensation number depending on those available on the tool. The other parameters are optional in



this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is at: Motion at machining feedrate from 1 to 2 Dwell for specified duration Retract at retract feedrate from 2 to 3. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Reaming operations: CYCLE/REAM, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/REAM, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Counterboring Operation This task shows how to insert a Counterboring operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Counterboring icon



.



A Counterboring entity along with a default tool is added to the program. The Counterboring dialog box appears directly at the Geometry tab page .



2. Select the red hole depth representation then select hole geometry in the 3D window. Just double click to end your selection.



3. If needed, select the tool axis direction. 4. Select the Strategy tab page



and



specify the following machining parameters. Approach clearance Depth mode: by tip The depth value used is the one specified in the Geometry tab page. Dwell Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the toolpath represented in the strategy page, tool motion is at: Motion at machining feedrate from 1 to 2 Dwell for specified duration Retract at retract feedrate from 2 to 3. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Counterboring operations: CYCLE/CBORE, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/CBORE, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Boring Operation This task shows how to insert a Boring operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Boring icon



.



A Boring entity along with a default tool is added to the program. The Boring dialog box appears directly at the Geometry tab page . 2. Select the red hole depth representation then select 4 hole features. Just double click to end your selections. The sensitive icon is updated with the following information: depth and diameter of the first selected feature hole extension type: through hole number of points to machine. 3. If needed, select the tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters: approach clearance depth mode: by tip The depth value used is the one specified in the Geometry tab page breakthrough distance dwell compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds



tab page to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Dwell for specified duration Retract at retract feedrate from 2 to 3. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Boring operations: CYCLE/BORE, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/BORE, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Boring Spindle Stop Operation This task shows how to insert a Boring Spindle Stop operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Boring Spindle Stop icon . A Boring Spindle Stop entity along with a default tool is added to the program. The Boring Spindle Stop dialog box appears directly at the Geometry tab page . 2. Select the red hole depth representation then select hole geometry in the 3D window. Just double click to end your selections. The sensitive icon is updated with the following information: depth and diameter of the first selected hole hole extension type: through Number of points to machine. 3. If needed, select the tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters. approach clearance depth mode: by tip The depth value used is the one specified in the Geometry tab page. breakthrough distance shift: by linear coordinates (along X) dwell compensation number depending on those available on the tool. The other parameters are optional in



this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion with a boring bar is as follows: Motion at machining feedrate from 1 to 2 Dwell for specified duration Spindle stop Shift motion at retract feedrate from 2 to 3 Retract at retract feedrate from 3 to 4 Shift motion at retract feedrate from 4 to 1. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page to specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation.



Example of output If your PP table is customized with the following statement for Boring Spindle Stop operations: CYCLE/BORE, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, ORIENT, %MFG_XOFF, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/BORE, 25.000000, 500.000000, MMPM, 5.000000, ORIENT, 1.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Boring and Chamfering Operation This task shows how to insert a Boring and Chamfering operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Boring and Chamfering icon . A Boring and Chamfering entity along with a default tool is added to the program. The Boring and Chamfering dialog box appears directly at the Geometry tab . page 2. Select the red hole depth representation then select hole geometry in the 3D window. Just double click to end your selections. The sensitive icon is updated with the following information: depth and diameter of the first selected feature hole extension type: through hole number of points to machine. 3. If needed, select tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters. approach clearances 1 and 2 depth mode: by shoulder The depth value used is the one specified in the Geometry tab page breakthrough distance chamfer diameter dwell first compensation number depending on those available on the tool for boring



second compensation number depending on those available on the tool for chamfering.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Boring



Motion at machining feedrate from 1 up to the position where hole is to be bored Possibly, activation of second tool compensation number Rapid feedrate up to a clearance position before start of chamfering. Chamfering



Motion at chamfering feedrate from clearance position to 2 Dwell for specified duration Possibly, activation of first tool compensation number Retract at retract feedrate from 2 to 3. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation.



to



Example of output If your PP table is customized with the following statement for Boring and Chamfering operations: CYCLE/BORE, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/BORE, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Back Boring Operation This task shows how to insert a Back Boring operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Back Boring icon



.



A Back Boring entity along with a default tool is added to the program. The Back Boring dialog box appears directly at the Geometry tab page



.



2. Select the top plane representation then select the top of the part. 3. Select the red hole depth representation then specify the hole pattern to be machined by selecting two counterbored features in the 3D window. Just double click to end your selections. The Geometry page is updated with information about the first selected feature.



4. If needed, select the tool axis direction. 5. Select the Strategy tab page to specify the following machining parameters. approach clearance depth mode: by tip The depth value used is the one specified in the Geometry tab page shift: by linear coordinates (along X) dwell compensation number depending on those available on the tool.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 6. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Shift motion at rapid feedrate from 1 to 2 Motion at rapid feedrate from 2 to 3 Shift motion at rapid feedrate from 3 to 4 Motion at machining feedrate from 4 to 5 Dwell for specified duration Motion at machining feedrate from 5 to 6 Shift motion at approach feedrate from 6 to 7 Retract at retract feedrate from 7 to 8 Shift motion at approach feedrate from 8 to 9. 7. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 8. Click OK to create the operation.



to



Example of output If your PP table is customized with the following statement for Back Boring operations: CYCLE/BORE, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, ORIENT, %MFG_XOFF, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/BORE, 25.000000, 500.000000, MMPM, 5.000000, ORIENT, 1.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Tapping Operation This task shows how to insert a Tapping operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Tapping icon



.



A Tapping entity along with a default tool is added to the program. The Tapping dialog box appears directly at the Geometry tab page . This tab page includes an icon representing a simple hole. There are several hot spots in the icon. 2. Select the red hole depth representation then select a threaded hole feature in the 3D window. Just double click to end your selection. The sensitive icon is updated with the following information: hole depth, thread depth, and diameter hole extension type: blind. 3. If needed, select tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters. approach clearance depth mode: by shoulder The depth value used is the one specified in the Geometry tab page. compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Reverse spindle rotation Retract at machining feedrate from 2 to 3 Reverse spindle rotation. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 6. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Tapping operations: CYCLE/TAP, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP A typical NC data output is as follows: CYCLE/TAP, 38.500000, 500.000000, MMPM, 2.500000 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Reverse Threading Operation This task shows how to insert a Reverse Threading operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1.



Select the Reverse Threading icon



.



A Reverse Threading entity along with a default tool is added to the program. The Reverse Threading dialog box appears directly at the Geometry tab page .



2.



Select the red hole depth representation then select a threaded hole feature in the 3D window. Just double click to end your selection. The sensitive icon is updated with the following information: hole depth, thread depth, and diameter hole extension type: blind.



3. 4.



If needed, select the tool axis direction. Select the Strategy tab page to specify the following machining parameters. approach clearance depth mode: by shoulder The depth value used is the one specified in the Geometry tab page. compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5.



Select the Feeds and Speeds tab page



6.



Note that in the tool path represented in the strategy page, tool motion is at: Motion at machining feedrate from 1 to 2 Spindle off then reverse spindle rotation Retract at machining feedrate from 2 to 3. If you want to specify approach and retract motion for the operation, select the Macros tab page



to specify the feedrates and spindle speeds for the operation.



specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7.



Click OK to create the operation. Example of output If your PP table is customized with the following statement for Reverse Threading operations: CYCLE/TAP, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP A typical NC data output is as follows: CYCLE/TAP, 38.500000, 500.000000, MMPM, 2.500000 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Thread without Tap Head Operation This task shows how to insert a Thread without Tap Head operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Thread without Tap Head icon . A Thread without Tap Head entity along with a default tool is added to the program. The Thread without Tap Head dialog box appears directly at the Geometry tab . page 2. Select the red hole depth representation then select a threaded hole feature in the 3D window. Just double click to end your selection. The sensitive icon is updated with the following information: hole depth, thread depth, and diameter hole extension type: blind. 3. If needed, select the tool axis direction. 4. Select the Strategy tab page and specify the following machining parameters. approach clearance depth mode: by tip The depth value used is the one specified in the Geometry tab page. compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the toolpath represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Spindle stop Retract at retract feedrate from 2 to 3. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Thread without Tap Head operations: CYCLE/TAP, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP A typical NC data output is as follows: CYCLE/TAP, 38.500000, 500.000000, MMPM, 2.500000 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Countersinking Operation This task shows how to insert a Countersinking operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Countersinking icon



.



A Countersinking entity along with a default tool is added to the program. The Countersinking dialog box appears directly at the Geometry tab page .



2. Select the red hole depth representation then select hole geometry in the 3D window. Just double click to end your selections.



3. If needed, select the tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters. Approach clearance Depth mode: by distance The depth value used is the one specified in the Geometry tab page. Dwell Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the toolpath represented in the strategy page, tool motion is at: Motion at machining feedrate from 1 to 2 Dwell for specified duration Increment at finishing feedrate from 2 to 3 Retract at retract feedrate from 3 to 4. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation.



Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation. Example of output If your PP table is customized with the following statement for Countersinking operations: CYCLE/CSINK, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/CSINK, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



to



Create a Chamfering Two Sides Operation This task shows how to insert a Chamfering Two Sides operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1. Select the Chamfering Two Sides icon . A Chamfering Two Sides entity along with a default tool is added to the program. The Chamfering Two Sides dialog box appears directly at the Geometry tab . page



2. Select the red hole depth representation then select the hole geometry in the 3D window. Just double click to end your selections. 3. If needed, select the tool axis direction. 4. Select the Strategy tab page to specify the following machining parameters: approach clearances 1 and 2 depth mode: by tip breakthrough distance dwell in seconds first compensation number depending on those available on the tool for top chamfering second compensation number depending on those available on the tool for bottom chamfering. Please note that the depth value and chamfer diameter are retrieved from your geometry selections.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5. Select the Feeds and Speeds tab page



to specify the feedrates and spindle speeds for the operation.



Note that in the tool path represented in the strategy page, tool motion is as follows: Motion at machining feedrate from 1 to 2 Dwell for specified duration Possibly, activation of second tool compensation number (output point change) Motion at approach feedrate from 2 to 3 Motion at machining feedrate from 3 to 4 Dwell for specified duration Possibly, activation of first tool compensation number (output point change) Retract at retract feedrate from 4 to 5. 6. If you want to specify approach and retract motion for the operation, select the Macros tab page specify the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7. Click OK to create the operation.



to



Example of output If your PP table is customized with the following statement for Chamfering Two Sides operations: CYCLE/BORE, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL A typical NC data output is as follows: CYCLE/BORE, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a T-Slotting Operation This task shows how to insert a T-Slotting operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1.



Select the T-Slotting icon



.



A T-Slotting entity along with a default tool is added to the program. The T-Slotting dialog box appears directly at the Geometry tab page .



2.



Select the red hole depth representation then select hole geometry in the 3D window. Just double click to end your selections.



3. 4.



If needed, select the tool axis direction. to Select the Strategy tab page specify the following machining parameters. Approach clearance Depth mode: by tip The depth value used is the one specified in the Geometry tab page. Dwell Compensation number depending on those available on the tool. The other parameters are optional in this case.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 5.



Select the Feeds and Speeds tab page



6.



Note that in the toolpath represented in the strategy page, tool motion is at: Motion at approach feedrate from 1 to 2 Motion at machining feedrate from 2 to 3 Retract at retract feedrate from 3 to 4. If you want to specify approach and retract motion for the operation, select the Macros tab page



to specify the feedrates and spindle speeds for the operation.



to specify



the desired transition paths. The general procedure for this is described in Define Macros of an Axial Machining Operation. Before accepting the operation, you should check its validity by replaying the tool path. 7.



Click OK to create the operation. Example of output If your PP table is customized with the following statement for T-Slotting operations: CYCLE/TAP, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP A typical NC data output is as follows: CYCLE/TAP, 38.500000, 500.000000, MMPM, 2.500000 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Create a Circular Milling Operation This task shows how to insert a Circular Milling operation in the program. To create the operation you must define: the geometry of the holes to be machined the tool that will be used the parameters of the machining strategy the feedrates and spindle speeds the macros (transition paths)



.



Open the HoleMakingOperations.CATPart document, then select the desired NC Manufacturing workbench from the Start menu. Make the Manufacturing Program current in the specification tree. 1.



Select the Circular Milling icon



.



A Circular Milling entity along with a default tool is added to the program. The Circular Milling dialog box appears directly at the Geometry tab page .



2.



Enter Offset values for the Bottom and Contour.



3.



Select the red hole depth representation then select hole geometry in the 3D window. Just double click to end your selections.



4. 5.



If needed, select the tool axis direction. to Select the Strategy tab page specify the following machining parameters. Approach clearance Number and distance between paths Axial mode: Maximum depth of cut or Number of levels Sequencing mode Machining tolerance Direction of cut Percentage overlap Automatic draft angle Compensation number depending on those available on the tool.



You can choose between the standard tip output and a cutter profile output by means of the Output style option. If a cutter profile style is selected, both the tip and cutter profile will be visualized during tool path replay. The cutter profile output allows easier tool compensation to be done on the shop floor.



A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page



to specify the tool you want to use.



This is described in Edit the Tool of an Operation. 6.



Select the Feeds and Speeds tab page



7.



Note that in the toolpath represented in the strategy page, tool motion is at: Motion at machining feedrate from 1 to 2 Motion at feedrates defined on macros from 2 to 3, 3 to 4, 4 to 2', 2' to 3' and 3' to 4' Retract at retract feedrate from 4' to 5. Select the Macros tab page to specify the operation's transition paths (approach and retract motion, for



to specify the feedrates and spindle speeds for the operation.



example). The general procedure for this is described in Define Macros of an Operation. Before accepting the operation, you should check its validity by replaying the tool path. 8.



Click OK to create the operation.



Example of output If your PP table is customized with the following statement for Circular Milling operations: CYCLE/CIRCULARMILLING, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP A typical NC data output is as follows: CYCLE/CIRCULARMILLING, 38.500000, 500.000000, MMPM, 2.500000 However, if the Syntax Used option is set to No for NC Output generation, then GOTO points will be generated instead of this PP word syntax.



Auxiliary Operations This section shows you how to insert auxiliary operations in the manufacturing program. Insert Tool Change: Select the Tool Change icon then select the tool type to be referenced in the tool change. Insert Machine Rotation: Select the Machine Rotation icon then specify the tool rotation characteristics. Insert Machining Axis System or Origin: Select the Machining Axis or Origin icon then specify the characteristics of the machining axis system or origin. Insert PP Instruction: Select the PP Instruction icon then enter the syntax of the PP instruction.



Insert a Tool Change This task shows how to insert tool changes in the program. You can either add tool changes locally or generate all necessary tool changes automatically in the program. 1. To add a tool change locally: In the specification tree, select the program entity after which you want to add the tool change.



2.



Select the Tool Change icon



.



The Tool Change dialog box appears.



3.



Select the Tool tab page



in order to



specify the tool to be referenced by the tool change. You can do this by either: creating a new tool selecting another tool that is already used in the document selecting another tool either in the document or in tool catalogs by means of a query. This is the same procedure as described in Select or Create a Tool.



4.



Select the Syntax tab page



5.



Select the Init from PP Table checkbox to consult the tool change syntax defined in the PP table that is referenced by the Part Operation. Otherwise, enter a PP Instruction for your tool change. This user-defined syntax has no link with the PP table and its validity is not checked by the program. If the PP Instruction comprises a sequence of PP word syntaxes, you can choose the sequence to be used by means of the Sequence Number spinner. Click OK to create the tool change in the program.



.



You can click Replay to visualize the tool at the tool change point in the program.



1.



To generate tool changes automatically: Right click the Manufacturing Program entity in the specification tree and select Generate Tool Changes from the contextual menu.



2.



The program is updated with all necessary tool changes. To delete tool changes that were automatically generated : Right click the Manufacturing Program entity in the specification tree and select Delete Generated Tool Changes from the contextual menu. All tool changes that were automatically generated are removed from the program.



Insert a Machine Rotation This task shows how to insert a machine rotation in the program. You can either add machine rotations locally or generate all necessary machine rotations automatically in the program. Either the program or a program entity must be current in the specification tree. 1. To add a machine rotation locally: In the specification tree, select the program entity after which you want to add the machine rotation, then select the . Machine Rotation icon The Machine Rotation dialog box appears. 2. Select the Properties tab page



to



specify the characteristics of the Machine rotation. 3. Select the rotary direction: Clockwise Counter-clockwise. 4. Enter the value of the angle of rotation about the rotary axis. Note that this rotary axis (A, B or C) is defined on the machine referenced by the Part Operation. The rotary type is set to Absolute in this version. 5. Select the Syntax tab page



.



Select the Init from PP Table checkbox to consult the machine rotation syntax defined in the PP table that is referenced by the Part Operation. Otherwise, enter a PP Instruction for your machine rotation. This user-defined syntax has no link with the PP table and its validity is not checked by the program. 6. Click OK to accept creation of the machine rotation in the program. 1. To generate machine rotations automatically: Right click the Manufacturing Program entity in the specification tree and select Generate Machine Rotations from the contextual menu. The program is updated with all necessary machine rotations. 2. To delete machine rotations that were automatically generated: Right click the Manufacturing Program entity in the specification tree and select Delete Generated Machine Rotations from the contextual menu. All machine rotations that were automatically generated are removed from the program.



Insert a Machining Axis or Origin This task shows how to insert a machining axis or origin auxiliary operation in the program. A feature representation of the corresponding axis system will be created in the 3D view. Output coordinates are computed in the current machining axis system as shown in the example below. Tool path computed in machining axis system AXS1 with origin (0,0,0): $$*CATIA0 $$*AXS1 $$ 1.00000 0.00000 0.00000 0.00000 $$ 0.00000 1.00000 0.00000 0.00000 $$ 0.00000 0.00000 1.00000 0.00000 GOTO/ -40.00000, -30.00000, 20.00000 GOTO/ -40.00000, 30.00000, 20.00000



Same tool path computed in machining axis system AXS2 with origin (0,0,20): $$*CATIA0 $$*AXS2 $$ 1.00000 0.00000 0.00000 0.00000 $$ 0.00000 1.00000 0.00000 0.00000 $$ 0.00000 0.00000 1.00000 20.00000 GOTO/ -40.00000, -30.00000, 0.00000 GOTO/ -40.00000, 30.00000, 0.00000



Either the program or a program entity must be current in the specification tree. 1.



Select the Machining Axis or Origin icon



.



The Operation Definition dialog box is displayed directly at the Geometry tab page . You can now select geometric elements to define your axis system.



2.



Select the symbol representing the origin in the sensitive icon.



3.



Select a point or a circle to define the origin of the machining axis.



4.



Select one of the axes (Z, for example) in the sensitive icon to specify the orientation of that axis. The following dialog box appears.



The Z axis is the privileged axis. You should define it first, then specify the X axis. The XY plane is always perpendicular to the Z axis.



5.



6.



Select the desired method to specify the orientation using the combo: Manual: by means of X, Y, Z components Selection Main axis: from a pre-defined list. Just click OK to accept the specified orientation. Repeat this procedure to specify the orientation of another axis (X, for example). The specified origin and X and Z axes are sufficient to define the machining axis system. You can also define a machining axis by selecting one of the triangular areas in the sensitive icon.



7.



You can then select an existing axis system and position it by selecting a point in the 3D view. You can click the Origin checkbox if you want to specify an origin. For certain machine types it may be useful to specify an origin number and group. This will result in the following type of output syntax: $$*CATIA0 $$Origin.1 $$ 1.00000 0.00000 0.00000 0.00000 $$ 0.00000 1.00000 0.00000 0.00000 $$ 0.00000 0.00000 1.00000 0.00000 ORIGIN/ 0.00000,0.00000,0.00000, 1, 1



9.



This output is for an origin with coordinates (0,0,0) and whose origin number and group are both equal to 1. You can enter a name for the machining axis or origin to be created. This name will be visualized beside the representation of the axis system in the 3D view. Select the Syntax tab page .



10.



Select the Init from PP Table checkbox to consult the Machining Axis or Origin syntax defined in the PP table that is referenced by the Part Operation. Otherwise, enter a PP Instruction for your machining axis or origin. This user-defined syntax has no link with the PP table and its validity is not checked by the program. Click OK to create the machining axis or origin auxiliary operation in the program.



8.



A feature representation of the corresponding axis system is created in the 3D view.



Insert a PP Instruction This task shows how to insert a PP instruction in the program. Either the program or a program entity must be current in the specification tree. 1. In the specification tree, select the program entity after which you want to add the PP instruction.



2. Select the PP Instruction icon



.



The Post-Processor Instruction dialog box appears.



3. Enter the syntax of a PP instruction. Please note that the program does not check the validity of your syntax. 4. Click OK to create the PP instruction in the program.



Part Operation and Manufacturing Program This section deals with creating and managing the following major entities of the CATIA manufacturing environment. Create and Edit a Part Operation: Select the Part Operation icon then specify the entities to be referenced by the part operation: machine tool, machining axis system, tool change point, part set up, and so on. Create and Edit a Manufacturing Program: Select the Manufacturing Program icon to add a program to the current part operation then insert all necessary program entities: machining operations, tool changes, PP instructions, and so on.



Part Operation This task shows you how to create a part operation in the manufacturing process. When you open an NC Manufacturing workbench on a CATPart or CATProduct document, the manufacturing document is initialized with a part operation. 1.



Select the Part Operation icon



.



A new part operation is initialized in the manufacturing process and a Part Operation entity is added to the tree. To access the parameters of the part operation, double click the Part Operation entity in the tree or use the contextual menu. The Part Operation dialog box appears.



2.



3.



If needed, enter a new part operation name and assign comments to the part operation.



Click the Machine icon



to assign a machine tool to the part operation.



The Machine Editor dialog box appears.



4.



Select the desired type of machine tool by clicking the corresponding icon: 3-axis machine 3-axis machine with rotary table 5-axis machine. The default characteristics of the selected machine type are displayed and the following parameters can be edited to correspond to your actual machine tool. Machine name and associated comments Numerical control parameters such as PP words table Spindle parameters Tool change parameters such as Tools catalog Rotary table parameters for 3-axis machine with rotary table.



5.



Just click OK to accept the machine parameters and return to the Part Operation dialog box. Click the Machining Axis icon to assign a reference machining axis system to the part operation. The Machining Axis dialog box appears. This is similar to the procedure described in Insert a Machining Axis Change.



6.



Output coordinates will be described in the specified axis system except when local machining axis systems are inserted in the program. to associate an existing product (CATProduct) or part (CATPart) to the part operation. Click the Product icon This procedure is described in Set Up and Part Positioning.



7.



Select the Geometry tab to associate the following geometry to the part operation: Design part Just click the Design Part icon then select the desired geometry. This is useful if you want to do material removal simulations later. Stock Just click the Stock icon then select the desired geometry. This is useful if you want to do material removal simulations later. Safety plane



8.



9.



Just click the Safety Plane icon then select the desired plane that will be used as a global safety plane for the part operation. Select the Position tab to specify the following entities on the part operation: tool change point part setup on the machine. Click OK to create the part operation. The tree is updated with the new entity.



Manufacturing Program This task shows you how you can edit a manufacturing program. A number of capabilities are available for managing manufacturing programs: Create Insert entities Reorder using Copy / Paste or Drag / Drop Delete. When you open an NC Manufacturing workbench on a CATPart document, the manufacturing document is initialized with a manufacturing program. When you select the Manufacturing Program icon



, a new program is initialized in the part operation and a new



Manufacturing Program entity is added to the tree. Open the HoleMakingOperations.CATPart document, then select NC Manufacturing > Prismatic Machining from the Start menu. Make the Manufacturing Program current in the specification tree. 1.



Create a drilling operation on a pattern of two holes.



2.



Create a spot drilling operation on the same holes.



3.



Create another drilling operation on another pattern of four holes. The three operations are assigned the same default tool.



4.



Edit the spot drilling operation to assign a spot drill tool. Each operation now has an associated tool change.



5.



Right click the second Drilling operation and select the Cut command.



6.



Right click the first Drilling operation and select the Paste command. The program is now reordered and the number of tool changes reduced.



The same result could have been obtained by using the drag and drop capability.



Managing Manufacturing Entities This section deals with creating and managing the specific entities of the CATIA manufacturing environment (other than machining operations and auxiliary commands). Select or Create a Tool: Double click the machining operation in the program and select the Tool tab page to edit the tool characteristics or search for a new tool. Edit a Tool Referenced in the Program: Double click a tool referenced in the program or resource list and edit the tool characteristics in the Tool Definition dialog box. Specify Tool Compensation Information: Double click a tool referenced in the program or resource list and specify the tool compensation information in the Compensation tab page of the Tool Definition dialog box . Create and Use Machining Patterns: Select Insert > Machining Feature > Machining Pattern then select a pattern of holes to be machined. Feature Based Programming: Select a feature using the Manufacturing view and create operations based on this feature. Define Macros on a Milling Operation: Select the Macros tab page when creating or editing a milling operation, then specify the transition paths of the macros to be used in the operation. Define Macros on an Axial Machining Operation: Select the Macros tab page when creating or editing an axial machining operation, then specify the transition paths of the macros to be used in the operation. Manage the Status of Manufacturing Entities: Use the status lights to know whether or not your operation is correctly defined.



Select or Create a Tool This task shows you how to edit the tool of an operation. You can either: create a new tool select another tool that is already used in the document select another tool by means of a query. 1. Double click the operation in the program, then select the Tool tab page. 2. To create a new tool: If you want to change tool type, select the icon corresponding to the desired tool type. In this case the corresponding tool representation appears in the 2D viewer. Double click the geometric parameter that you want to modify in the 2D viewer, then enter the desired value in the Edit Parameters dialog box that appears. Modify other parameters in the same way. The tool representation is updated to take the new values into account. Click More to expand the dialog box to access all the tool's parameters. Modify the values as desired. Use the spinner to increment the Tool number. Enter a name for the new tool.



3. To select a tool that is already used in the document: Select the button opposite Name. Select the desired tool from the list of tools already used in your document. If necessary, you can edit the parameters of this tool as described above. 4. To select another tool by means of a query: Click the Select a tool by query icon opposite Name. The Search Tool dialog box appears. You can choose to search in the current document or a tool catalog by means of the Look in combo. If you want to change tool type, select the icon corresponding to the desired tool type.



You can do a simple search by means of a character string on the tool name or a value for the tool's nominal diameter. The tools meeting the simple search criteria are listed. Select the desired tool from the list and click OK. The tool representation is displayed in the 2D viewer and can be edited as described above.



You can search a tool using finer constraints by selecting the Advanced tab page. The example below shows the result of a search for a tool with body diameter between 10 and 15 mm in the catalog ToolsSample02.



5. Click OK to confirm using this new tool in the operation.



Edit a Tool in the Program or Resource List This task shows you how to edit a tool that is already used in your document. 1.



Right click the tool you want to edit either in the program or in the resource list to access the Definition contextual command. The Tool Definition dialog box is displayed allowing you to edit the tool's geometric, technological and compensation characteristics.



2.



If needed, enter a new name for the tool.



3.



If needed, use the spinner to increment the Tool number.



4.



Click More to expand the dialog box to access the Geometry, Technology and Compensation tab pages.



5.



You can specify the tool geometry in two ways: double click a parameter in the large tool icon and enter the desired value in the Edit Parameter dialog box that appears or enter the desired values in the Geometry tab page. The icon representation of the tool is updated with these values.



6.



Click the Technology tab and enter the desired values for the tool's technological parameters.



7.



If tool compensation is required, click the Compensation tab. You can either edit an existing compensation site or add another site, if other sites are proposed for the type of tool being created.



8.



Right click the desired line to either edit or add tool compensation data.



9.



The Compensation Definition dialog box appears. Enter the desired values for the tool's compensation sites.



10.



See Specify Tool Compensation for more information. Click OK to accept the modifications made to the tool.



Specify Tool Compensation This task shows you how to specify tool compensation information. 1. Select the Compensation tab page of the Tool Definition dialog box. 2. Right click the desired compensation site to either edit or add tool compensation data. The Compensation Definition dialog box is displayed allowing you to specify the tool's compensation characteristics. 3. You can associate the following information to each compensation site on a tool: corrector number length register number radius register number (if radius compensation is allowed on the machine referenced by the part operation) diameter in order to specify the compensation site location (if allowed for the tool). Site P2 of a drill, for example. The following tool types have only one compensation site. This is the site P1 located at the extremity of the tool.



End mill



Face mill



Tap



Reamer



Boring tool



The following tool types have more than one compensation site. Some sites are defined by means of a diameter value.



Drill



Multi-diameter drill



Center drill



Spot drill



Boring and chamfering tool



T-slotter



Conical mill



Countersink



Two sides chamfering tool



4. Click OK to update the tool with the desired compensation information. It is possible to define tool compensation site numbers for all machining operation types, if tool compensation numbers are already defined on the tool used by the machining operation. In general, the tool compensation site number used by the operation can be specified. For operations such as Boring and Chamfering, Chamfering Two Sides or Contouring (when a T-slotter is used), two tool compensation site numbers can be used during machining.



Machining Patterns This task shows you how to: create a specific machining feature called machining pattern use this pattern of holes by referencing it directly in a drilling operation. Create a machining pattern 1.



Select the Manufacturing Feature View icon



2.



display the Manufacturing View. Select the Insert > Machining Features > Machining Pattern command.



3.



4.



to



A Machining Pattern entity is added to the Manufacturing View. Right click the Machining Pattern entity and select the Definition contextual menu command. The Machining Pattern dialog box is displayed. Click the No Points sensitive text in the dialog box, then select the points to be included in the machining pattern. The icon is updated with this information.



5.



Click OK to create the machining pattern.



Use a machining pattern in a machining operation 1.



Select the Drilling icon



.



The Drilling dialog box appears directly at the Geometry tab page.



2.



This tab page includes a sensitive icon to help you specify the geometry of the hole or hole pattern to be machined. Select the red hole depth representation then select the machining pattern from the displayed list.



3.



The pattern is highlighted in the model. Click OK to create the drilling operation: the holes of the machining pattern will be drilled by this operation.



Features This task shows you how to use features displayed in the Manufacturing View for NC programming. 1. Select the Manufacturing Feature View icon



to display the



Manufacturing View.



2. Select a feature in the View (Hole5, for example). The operations to be created will be attached to this feature.



3. To attach a spot drilling operation to the feature, select the Spot Drilling icon . The Spot Drilling dialog box appears. Select the Geometry tab page. This tab page includes a sensitive icon to help you specify the geometry of the hole or hole pattern to be machined. 4. Click the 1 Point sensitive text in the dialog box, then select the points to be included along with Hole5 in the machining pattern (Hole6, Hole7, Hole8, for example). The icon is updated with this information.



5. Click OK to create the Spot Drilling operation, which is created with Machining Pattern.1 comprising 4 holes. The Manufacturing View is updated.



6. Select the Drilling icon



.



In Geometry tab page of the Drilling dialog box, click the No Points sensitive text in the dialog box, then select Machining Pattern.1 from the displayed list.



7. Click OK to create the Drilling operation, which is created with Machining Pattern.2, which references Machining Pattern.1 for the position of the four holes in the pattern. The Manufacturing View is updated.



8. Replay the two operations in the program to check that they both use the selected machining pattern based on the initial feature selection. You can use the contextual menu to sort the manufacturing view by Features, Patterns, Activities or Tools.



If you edit the Machining Pattern.1 (to include more points, for example) both the Spot Drilling and Drilling operations will be updated.



Define Macros on a Milling Operation This task shows you how to define macros on a milling operation. In this example you will create circular approach, circular retract and linking macros on a Profile Contouring operation. You must have created the previously described Profile Contouring operation. 1. 2. 3.



Double click the Profile Contouring operation. Select the Macros tab page . Click the Approach macro checkbox, then select the circular approach icon. A sensitive icon representing the elementary paths of the macro appears.



4.



Set the values of the approach macros paths so as to have a 10mm vertical path followed by a 15mm radius circular path. Just double click the displayed values in order to edit them. A dialog box appears to allow you to specify the exact characteristics of the circular path. You can click Replay to check the circular approach.



5. 6.



Click the Retract macro check box and create a circular retract macro in the same way. Click the Linking macro checkbox. Linking Retract is automatically displayed in the combo allowing you to specify the retract path of the linking macro. Select the linear retract path icon.



7.



Double click the displayed value, then assign an 20mm value to the retract path.



8.



Select Linking Approach in the combo. Select the linear approach path icon and assign a 20mm value to the approach path. Click the Cornerized Clearance with Radius checkbox, then enter a corner radius value of 3mm.



9.



10.



Click Replay to validate the tool path.



11.



In the Replay dialog box select the By colors mode in order to visualize feedrate changes. The tool path is displayed with the following colors: Yellow: approach feedrate Green: machining feedrate Blue retract feedrate Red: Rapid feedrate. Click OK to accept the modifications made to the operation.



12.



The operation is updated with the specified macros.



Define Macros on an Axial Machining Operation This task shows you how to define macros on an axial machining operation. In this example you will add approach, retract and linking macros to an existing Drilling operation. You must have created the previously described Drilling operation. 1. 2.



3.



Double click the Drilling operation. Select the Macros tab page



.



Click the Approach macro definition checkbox, then select the Add Axial Motion icon



.



A sensitive icon representing the elementary paths of the macro appears.



4.



Double click the displayed value in order to edit it. A dialog box appears to allow you to specify the desired distance (30mm, for example).



5. 6. 7.



Click the Retract macro definition checkbox and create a 30 mm axial retract motion in the same way. Click the Linking macro definition checkbox and create 25mm axial approach and retract motions for the linking macro. Click Replay to validate the tool path.



In the Replay dialog box select the By colors mode in order to visualize feedrate changes. The tool path is displayed with the following colors: Yellow: approach feedrate



Green: machining feedrate Blue: retract feedrate Red: Rapid feedrate Purple: plunge feedrate White: local feedrate. Note that if a jump distance is defined on the operation, it will be used in preference to the linking macro.



8.



Similarly if local entry/exit distances are defined on the operation, they will be used in preference to the linking macro. Click OK to accept the modifications made to the operation. The operation is updated with the specified macros.



Status Management This task shows you how the status of manufacturing entities is managed. 1.



Select the Pocketing icon



.



The Pocketing Definition dialog box appears directly at the Geometry tab page. The status light on the tab is red indicating that you must specify the geometry to be machined by the operation. symbol on the Pocketing entity in the A specification tree also indicates that the operation definition is incomplete. 2.



Select the required pocket geometry. The status light switches to green on the tab



.



The status lights on the Strategy , Feeds and Macros tab are all green indicating that default values are already set for operation creation. You can of course modify these values. Just select the corresponding tab to access these parameters.



3.



tab is orange. This indicates that, although a default tool is set for the The status lights on the Tool operation, you may want to modify or change that tool for a more suitable one. When all the status lights are green you generally have sufficient conditions to create the operation. Just click OK to create the operation. Remember that you should always check the operation's tool path by means of a replay. symbol on the Pocketing tree entity is The removed when the operation definition is complete. The operation name in the specification tree is appended with the text Computed after a replay is done on the operation.



Verification, Simulation and Program Output This section shows you how to use the various tools provided with the product such as tool path verification, material removal simulation, and production of NC output data. Replay Tool Path: Select the Tool Path Replay icon then specify the display options for an animated tool path display of the manufacturing program of machining operation. Simulate Material Removal: Select the desired icon in the Tool Path Replay dialog box to run a material removal simulation either in Photo or Video mode. Generate APT Source Code in Batch Mode: Select the Generate NC Code in Batch Mode icon then select the manufacturing program to be processed and define the APT source processing options. Generate ISO NC Code in Batch Mode: Select the Generate NC Code in Batch Mode icon then select the manufacturing program to be processed and define the ISO NC code processing options. Generate APT Source Code in Interactive Mode: Select the Generate NC Code Interactively icon to generate APT source code for the current manufacturing program. Generate NC Documentation: Select the Generate Documentation icon to produce shop floor documentation in HTML format. Import an APT Source into the Program: Select the APT Import contextual command to insert an existing APT source into the current manufacturing program.



Replay a Tool Path This task shows you how to replay the tool path of an operation. You can also replay the tool path of a manufacturing program. 1. Select the operation in the tree, then select the Replay icon . You can also right-click the operation in the tree and select Replay Tool Path from the contextual menu. The Replay dialog box appears.



You can also access the Replay dialog box directly from the Operation Definition dialog box. 2. Choose one of the replay modes by selecting one of the drop down icons: Point to Point Continuous Plane by Plane Feedrate by Feedrate



.



3. Choose one of the Tool Visualization modes by selecting one of the drop down icons: Tool displayed at last position only Tool axis displayed at each position Tool displayed at each position . 4. Choose a Color mode by selecting one of the drop down icons: Tool path displayed in same color Tool path displayed in different colors for different feedrates . 5. Click the



button to position the tool at the operation start point, then



to start the replay.



You can use the other Tool Animation buttons to move the tool along the tool path as follows: to go to the operation end point to run the replay in reverse mode to request a pause in the replay. 6. Click OK to quit the replay mode.



If the operation has been deactivated by means of the Deactivate command, it cannot be replayed. If you want to replay the operation, you must reactivate it using the Activate command. Similarly, if the manufacturing program has been deactivated by means of the Deactivate command, it cannot be replayed. If you want to replay the program, you must reactivate it using the Activate command. If a Profile Contouring operation was created with the cutter profile output option, both the cutter profile and tip trajectory will be displayed in the replay. If a user-defined tool representation is related to the operation, that tool will be displayed in the replay.



Material Removal Simulation This task shows you how to simulate the material removed by a machining operation. Two modes are available: Photo and Video. In Photo mode, you can only simulate operations whose tool axis is the same as the Z-axis of the Part Operation's machining axis system. In Video mode, if the stock geometry is not correctly closed, a stock representing the envelope volume of the design part is computed. Select the operation in the tree, then select the Replay icon . You can also right-click the operation in the tree and select Replay Tool Path from the contextual menu. The Replay dialog box appears.



1.



Material Removal - Photo mode Select the Photo icon



.



The result of the material removal is displayed in a window entitled Photo. The following icons become available for analyzing the result of the simulation: for comparing the machined part with the design part. for customizing material removal settings.



2.



Select the Analyze Photo icon



.



The Errors dialog box appears that gives details of all errors found. 3.



In the Filter Setting section, select the desired fault types and specify the Tolerance for the comparison. The fault filter setting permits three types of faults: Gouge: areas where the tool has removed excess material from the workpiece. Undercut: areas where the tool has left behind material on the workpiece.



Tool Clash: areas where the tool collided with the workpiece during a rapid move.



4.



Click the Compare button. The machined part is compared with the design part based on the specified Filter Setting. Any point on the machined surface of the workpiece is considered to be part of a fault if the normal distance (normal deviation) to the design part surface is greater than the specified tolerance. Results of the comparison are reflected on the workpiece, based on the extent of severity of the fault and the customized color settings. The list of detected faults are listed in the Faults combo box. The faults are ordered in such a way that Tool Clash appears at the top of the list followed by Gouge and Undercut. The gouges and undercuts are in turn sorted on the basis of decreasing fault area. On selecting a fault from the Faults combo box, the region corresponding to the fault is indicated by a "Fault Indicator" bounding box on the workpiece. Other detailed information about the selected fault is displayed. If needed, you can update the program data and display by clicking on the Photo icon again.



5.



At any time you can pick on the surface of the workpiece. A dialog box appears giving information about the pick point: The operation used for removing material. The normal deviation between the workpiece and the design part. The X, Y, and Z coordinates of the pick point. The tool used for machining. Click Close to quit the Analyze Photo mode and return to the Replay dialog box.



1.



Material Removal - Video mode Select the Video icon



.



The Material removal video is displayed in a window entitled Video. The Replay mode is set to Point to Point.



2.



3.



Use the Tool animation replay buttons to run the material simulation video: run run one block stop rewind run reverse. If needed, click the Save Video icon to save the material simulation video.



4.



The Save Machined Workpiece dialog box appears allowing you to save the result of the simulation video in a cgr type file. Click OK to quit the Replay dialog box.



Generate NC Code Interactively This task shows you how to generate NC code from the program in interactive mode. For best results, you should have verified the operations of your program by replay or simulation. There should be no operations to be updated or in an undefined state. The generated NC code is in APT format. 1. Select the Manufacturing Program entity in the tree, then select the Generate NC . Code Interactively icon You can also use the right mouse key on the Manufacturing Program entity to select Generate NC code. The Save NC File dialog box appears.



2.



Select the folder where the file is to be saved and specify the name of the file.



3.



Click Save to create the APT file. The generated APT file can be browsed with any kind of editor.



Generate NC Code in Batch Mode This task shows you how to generate the NC code from the program in batch mode. The NC code is generated in APT format. Always save your program modifications before generating the NC code. For best results, you should have verified the operations of your program by replay or simulation. There should be no operations to be updated or in an undefined state. 1. Select the Manufacturing Program entity in the tree, then select the Generate NC Code in Batch Mode . icon The NC Batch Output dialog box appears. 2. In the In/Out tab page: Specify the manufacturing program to be processed by: either selecting the Current document check box or using the Document button and Program combo.



3. Select APT as the type of NC data output that you want. 4. Specify the file where you want the NC data to be written using the Output file button. 5. If needed, you can choose to write the document after processing. Just select the Save document checkbox and specify where you want to save it using the Document button. You can attach the generated output file to the selected manufacturing program by selecting the Associate document checkbox. The output file can be accessed by means of the Display NC File contextual command on the manufacturing program. 6. In the Options tab page: Specify the options to be used in the processing. Some of these options take machine characteristics into account (for example, Circular Interpolation). Others determine how information is to be presented on the output file (for example, information statements to be presented with the PPRINT syntax). Is Syntax Used is set to Yes, then for axial machining operations the PP word syntax specified in the PP word table will be output . Otherwise, GOTO statements will be generated. 7. Click Execute to request computation of the APT source file.



Generate ISO NC Code in Batch Mode This task shows you how to generate ISO NC code from the program in batch mode. Always save your program modifications before generating NC code. For best results, you should have verified the operations of your program by replay or simulation. There should be no operations to be updated or in an undefined state. 1. Select the Manufacturing Program entity in the tree, then select the Generate NC Code in Batch Mode . icon The Generate NC Output in Batch Mode dialog box appears. 2.



In the In/Out tab page: Specify the manufacturing program to be processed by: either selecting the Current document check box or using the Document button and Program combo.



3.



Select ISO as the type of NC data output that you want.



4.



Specify the file you want the NC data to be written using the Output file button.



5.



If needed, you can choose to write the document after processing. Just select the Save document checkbox and specify where you want to save the document. You can attach the generated output file to the selected manufacturing program by selecting the Associate document checkbox. The output file can be accessed by means of the Display NC File contextual command on the manufacturing program. The setting of certain options in the Options tab page may have an influence on the generated ISO NC code. In the ISO tab page:



6.



7.



Use the combo to select the desired Post Processor parameters file. Click Execute to request computation of the NC code. Sample Post Processor parameter files are delivered with the product in the folder \Startup\Manufacturing\PPPar which provides NC output for various machine types. For information about how to acquire Post Processor parameters files that provide machine specific ISO NC code output, please contact your IBM representative.



Generate NC Documentation This task shows how to generate NC documentation in HTML format. You can use the following scripting languages, depending on the platform you are running on: BasicScript 2.2 SDK for UNIX (BasicScript is a registered trademark of Summit Software Company) VBScript, short for Visual Basic Scripting Edition, for Windows NT (Visual Basic is a registered trademark of Microsoft Corporation). Users on NT machines must have Windows Scripting Host installed. You should have previously customized a CATScript file that defines the layout of the document you want to generate. Samples are delivered with the product in \Startup\Manufacturing\Documentation. 1. Select the NC Documentation icon . The Process Documentation dialog box appears.



2. 3. 4.



Select the CATScript file by clicking the button on the right of the Script field. In this version, just leave Process as the Process name. Specify the folder and file where the documentation is to be generated by clicking the button on the right of the Path field. Click Document Now to generate your documentation. A simple example is shown below.



APT Import This task shows how to import an existing APT file into the program. 1.



Right click the Manufacturing Program entity in the specification tree and select APT Import from the contextual menu. The Read NC File dialog box appears.



2. 3.



Navigate to find the folder in which the desired APT file is stored. Select the APT file in the displayed list then click Open to insert it in the program. You can right-click the APT Import entity in the specification tree to access a contextual menu that allows you to: replay the APT source file edit the APT source file definition.



Advanced Tasks The tasks described in this section deal with specific NC Manufacturing processes. Design Changes Set Up and Part Positioning



Design Changes This task shows you how to manage your design changes. 1.



Create a Profile Contouring operation and replay the tool path. All the tabs of the Profile Contouring dialog box display a green status.



2. 3.



The Profile Contouring entity is displayed in the tree with no related symbol. Switch to the window showing the CATpart design and modify the part geometry. Switch to the Set Up Editor manufacturing window.



4.



The Profile Contouring entity is now displayed in the tree with an Update symbol. Double click the Profile Contouring entity to edit the operation.



5.



The Geometry tab has an orange status, indicating that the geometry has been modified. Select the Analyze contextual command in the sensitive icon zone of the dialog box. The Geometry Analyzer dialog box appears showing the status of the referenced geometry.



6.



Click the Smart icon to highlight the geometry that was used in the operation before the part was modified. Geometry highlighted in this way helps you to analyze the design change.



7.



Click OK to return to the Profile Contouring dialog box.



8.



Replay the tool path to make sure that the machining is consistent with the design change. You should check that there is no longer an Update symbol beside the Profile Contouring entity in the graph.



Set Up and Part Positioning This task shows you how to manage part set up. You must create a CATProduct entity for each part set up you want to represent. 1. Enter an NC Manufacturing workbench and double click the Part Operation.1 entity in the tree. The Part Operation dialog box appears. 2. Click the Product icon to associate a product to the part operation.



3. Select a CATProduct from the Associated Product list, then click Open to display the corresponding part set up.



4. 5. 6. 7.



Click OK in the Part Operation dialog box. Click the Part Operation icon to create the Part Operation.2 entity in the tree. Associate another product to Part Operation.2 in the same way as described above. Click OK in the Part Operation dialog box.



To display the desired part set up, just select the corresponding Part Operation in the tree.



Workbench Description This section contains the description of the menu commands and icon toolbars that are specific to the Prismatic Machining workbench, which is shown below. Menu Bar Toolbars Specification Tree



CATIA Prismatic Machining Menu Bar The various menus and menu commands that are specific to Prismatic Machining are described below. Start



File



Edit



View



Insert



Tools



Windows



Help



Tasks corresponding to general menu commands are described in the CATIA Version 5 Infrastructure User's Guide.



Edit Menu Please note that most of the edit commands available here are common facilities offered by the CATIA Version 5 Infrastructure. The specific Prismatic Machining edit commands depend on the type of object being edited: Manufacturing Program or other entity.



Edit > Manufacturing Program.x object Command... Deactivate/Activate



Description... Deactivates the program for replay or NC output. It can be made active again with Activate. Hide/Show Children Hides the child nodes of the program. They can be visualized again with Show. See Replay the Tool Path. Replay Tool Path See Material Removal Init Photo Simulation. See Material Removal Refresh Photo Simulation. See Material Removal Analyze Photo Simulation. See Material Removal Photo Options Settings. See Generate NC Code Generate NC Code for the Program. Generate Tool Changes See Tool changes.



Delete Generated Tool Changes Generate Machine Rotations Delete Generated Machine Rotations APT Import



See Tool changes. See Machine Rotation. See Machine Rotation. See Import an APT file.



Edit > Part Operation.x object Command... Definition Activate/Deactivate Show/Hide Children



Description... Accesses the Part Operation's definition dialog box. Deactivates the Part Operation. It can be made active again. Hides the child nodes of the part operation. They can be shown again.



Edit > Machining Operation.x object Command... Definition Deactivate/Activate Hide/Show Children Replace Tool Replay Tool Path



Description... Accesses the operation's definition dialog box. Deactivates the operation for replay or NC output. It can be made active again. Hides the child nodes of the operation. They can be shown again. Allows replacing a tool on an operation. See Replay the Tool Path.



Edit > Manufacturing View.x object Command...



Description...



Sort by Features



Sort the view by features.



Sort by Patterns



Sort the view by patterns.



Sort by Activities



Sort the view by operations.



Sort by Tools



Sort the view by tools.



Insert Menu Command...



See...



Prismatic Operations



Insert > Prismatic Operations



Auxiliary Operations



Insert > Auxiliary Operations



Machining Features



Insert > Machining Features



Insert > Prismatic Operations Command... See... Drilling Operations Creating Hole Making Operations Creating a Pocketing Pocketing Operation Creating a Facing Facing Operation Profile Contouring Creating a Profile Contouring Operation Creating a Point to Point Point to Point Operation



Insert > Auxiliary Operations Command... Tool Change Machine Rotation Machining Axis or Origin



See... Creating a Tool Creating a Machine Rotation Creating a Machining Axis



Post-Processor Instruction Creating a PP Instruction



Insert > Machining Features Command... Milling Features > Machining Axis System Machining Pattern



Description... Machining Axis System feature, which is referenced in the machining axis or origin auxiliary operation. Machining Pattern



Tools Menu Please note that most of the Tools commands available here are common facilities offered by the CATIA Version 5 Infrastructure. Specific Prismatic Machining commands are described in the present document. Command... Description... Formula Allows editing parameters and formula. Image Allows capturing images. Allows recording, running and Macro editing macros. Allows viewing the parents Parent/Children and children of a selected object. Update Allows updating your session. Allows customizing the Customize workbench. See NC Manufacturing Options Settings. Allows specifying a search Search Order order list.



CATIA Prismatic Machining Toolbars The Prismatic Machining workbench includes a number of specific icon toolbars, which are described below. Manufacturing Program Toolbar Machining Operations Toolbar Auxiliary Operations Toolbar Tool Path Management Toolbar Machining Features Toolbar Manufacturing Auxiliary Views Toolbar Geometry Selection Toolbars



Manufacturing Program Toolbar This toolbar contains the following tools for creating manufacturing program and part operation entities.



See Part Operation See Manufacturing Program



Prismatic Operations Toolbar This toolbar contains the following commands to create and edit milling and axial machining operations.



See Create a Pocketing Operation See Create a Facing Operation See Create a Profile Contouring Operation See Create a Point to Point Operation



See Create a Drilling Operation See Create a Spot Drilling Operation See Create a Drilling Dwell Delay Operation See Create a Drilling Deep Hole Operation See Create a Drilling Break Chips Operation See Create a Tapping Operation See Create a Reverse Threading Operation See Create a Thread without Tap Head Operation See Create a Boring Operation See Create a Boring and Chamfering Operation See Create a Boring Spindle Stop Operation See Create a Reaming Operation See Create a Counterboring Operation See Create a Countersinking Operation See Create a Chamfering Two Sides Operation See Create a Back Boring Operation See Create a T-Slotting Operation



See Create a Circular Milling Operation



Auxiliary Operations Toolbar This toolbar contains the following tools for creating auxiliary operations in the program.



See Tool Change See Machine Rotation See Machining Axis System See PP Instruction



Tool Path Management Toolbar This toolbar contains the following tools to help you validate the tool path and generate NC output.



See Replay Tool Path See Generate NC Output in Batch Mode See Generate NC Output in Interactive Mode See Generate NC Documentation



Machining Features Toolbar This toolbar contains the following tools for managing machining features.



Machining Axis System. See Machining Patterns.



Auxiliary Manufacturing Views Toolbar This toolbar contains the following tools to help you manage auxiliary manufacturing views.



See Manufacturing View described in Machining Patterns. You can use the following commands on the Manufacturing View entity: sort by features sort by activities sort by patterns sort by tools. Import Tools. See procedure for searching tools described in Select or Create a Tool.



Geometry Selection Toolbars The toolbar below contains commands to help you select edges of contours when specifying geometry in machining operations.



Navigates tangentially on edges Closes the contour with a line Inserts lines on gaps Resets all selections Exits geometry selection mode. Cancels any already selected geometry. The toolbar below contains commands to help you select faces when specifying geometry in machining operations.



Navigates on faces Previews contours Resets all selections Exits geometry selection mode. Cancels any already selected geometry.



Specification Tree Here is an example of a Process Product Resources specification tree for Prismatic Machining. Process Product Resources (PPR) tree: The ProcessList is a plan that gives all the activities and machining operations required to transform a part from a rough to a finished state. The Part Operation defines the manufacturing resources and the reference data. The Manufacturing Program is the list of all of the operations and tool changes performed. Pocketing.1 operation is complete and has been computed. Pocketing.3 operation is complete but has not been computed. Pocketing.2 operation has not been computed and does not have all of the necessary data (indicated by the exclamation point). The ProductList gives all of the parts to machine. The ResourcesList gives all of the tools that can be used in the program.



Customizing The tasks in this section describe ways in which you can customize your CATIA NC Manufacturing environment. NC Manufacturing Settings Tools Catalog PP Word Syntaxes NC Documentation Material Simulation Settings



NC Manufacturing Settings This task briefly describes which settings you can customize. For more information, see Settings for NC Manufacturing products. 1. Select Tools > Options from the menu bar. 2.



Select the NC Manufacturing category in the tree to the left. The options for NC Manufacturing settings appear. They are organized in tab pages and allow you to customize: Display settings the display of the specification tree the tool display during tool path replay. the colors of displayed geometry and parameters the creation of a CATPart at Product level for storing geometry that is necessary for NC manufacturing Resources settings the path of the folder containing tools catalogs and PP tables the selection of tools Operations settings the use of default values for operation creation the creation of machining operations the duplication of geometry links when copying



3.



Output settings the selection of PP parameter files from different suppliers. Click OK to apply the settings and quit the dialog box.



Tools Catalog This task shows you how to build a customized tools catalog. You will have to customize an Excel file and a VB macro file in order to build your tools catalog. 1. Edit an Excel file with the desired tool descriptions.



The characteristic attributes of each tool type are described in Tools. You can include user-defined tool representations in your catalog. You do this by associating a CATPart document containing this representation to the desired tool in the last column of the Excel file. The user-defined tool representation will be displayed in the tool path replay. 2. Save the tool descriptions as a csv type file. 3. Edit the VB macro file to specify the input and output files. An example is shown below: '''''''''''''''''''''''''''''''''''''''''''''''''''''''''' '' VBScript for Manufacturing Tools catalog generation. '''''''''''''''''''''''''''''''''''''''''''''''''''''''''' Language="VBSCRIPT" Sub CATMain() csvFile ="MyCatalog.csv" catalogFile ="MyCatalog.catalog" 'Get the outputDir and inputDir environment variables inputDir = "HOME\Catalog" outputDir = "HOME\Catalog" 'Creates a catalog document Dim Catlg As Document Set Catlg=CATIA.Documents.Add("CatalogDocument")



InitData1=inputDir & "\" & csvFile Newcata1=outputDir & "\" & catalogFile 'Calls CreateCatalogFromcsv method on Catlg (ENDCHAPTER) Catlg.CreateCatalogFromcsv InitData1 , Newcata1 Catlg.Close End Sub



4. In your Version 5 CATIA session, select Tool > Macro > Macros. The Macro dialog box is displayed.



5. Select the VB macro file that you edited previously, then click Run.



The tools catalog is created (MyCatalog.catalog) along with a report file (MyCatalog.report). You can check this in the Search Tool dialog box.



PP Word Syntaxes This section shows you how to customize the following types of syntaxes in your PP word table: syntaxes associated to NC commands sequences of PP word syntaxes associated to NC instructions. The CATIA NC Manufacturing product will resolve the parameters of these syntaxes and syntax sequences and generate the corresponding statements in the APT output. A sample PP word table is delivered with the product in \Startup\Manufacturing\PPTables\PPTableSample.pptable It can be used as a basis for creating user-defined tables. Please refer to PP Tables and Word Syntaxes for more information.



1.



NC Commands You can define for a given machine tool (i.e post-processor) PP word syntaxes associated to particular NC commands. An NC command is a machine function such as feedrate declaration (NC_FEEDRATE) or spindle activation (NC_SPINDLE_START). A syntax comprises a major word and one or more syntax elements such as minor words, numerical values, list values and parameters. A syntax that includes lists or parameters is a parameterized syntax (see example below): *START_NC_COMMAND NC_FEEDRATE FEDRAT/%MFG_FEED_VALUE,&MFG_FEED_UNIT *END Note that the `&' character indicates a list and the `%' character indicates a parameter.



2.



3. 4.



You can define only one syntax for each NC command. The following example shows how the NC command NC_DELAY could be used in a Drilling Dwell Delay operation. Make sure that the PP word table is referenced by the machine used in the Part Operation and the syntax associated with the NC_DELAY command is already created as follows: *START_NC_COMMAND NC_DELAY DELAY/&MFG_DELAY_UNIT,%MFG_DELAY_VALUE *END Create a Drilling Dwell Delay operation. In the dialog box showing the available options, set the Dwell mode to Revolutions and enter a numerical dwell value of `5'. In this case the statement generated in the resulting APT source will be: DELAY/REV,5.000 If the operation was created with the Dwell mode set to Time Units and a dwell value of `5', the statement generated in the resulting APT source would be: DELAY/5.000



1.



NC Instructions You can define for a given machine tool (i.e post-processor) sequences of PP word syntaxes associated to particular NC instructions. NC instructions are either axial machining operations or auxiliary commands. A syntax comprises a major word and one or more syntax elements such as minor words, numerical values and standard parameters. A set of standard parameters is associated to each NC instruction. Parameters may be combined in arithmetical expressions. A syntax that includes parameters is a parameterized syntax (see example below): *START_NC_INSTRUCTION NC_TOOL_CHANGE *START_SEQUENCE TOOLNO/%MFG_TOOL_NUMBER,%MFG_NOMINAL_DIAM TPRINT/%MFG_TOOL_NAME LOADTL/%MFG_TOOL_NUMBER *END *END Note that the `%' character indicates a parameter.



2.



You can define one or more syntax sequences for each NC instruction. The following example shows how the NC instruction NC_DRILLING_DWELL_DELAY could be used to generate a specific NC data output. Make sure that the PP word table is referenced by the machine used in the Part Operation and the syntax associated with NC_DRILLING_DWELL_DELAY instruction is already created as follows: *START_NC_INSTRUCTION NC_TOOL_CHANGE *START_SEQUENCE CYCLE / DRILL, %MFG_TOTAL_DEPTH, %MFG_FEED_MACH_VALUE, &MFG_FEED_UNIT, %MFG_CLEAR_TIP, DWELL, %MFG_DWELL_REVOL *END *END



3. 4.



Create a Drilling Dwell Delay operation. In the dialog box showing the available options, set: hole depth to 25.0 feedrate to 500.0 approach clearance to 5.0 Dwell mode to Revolutions and enter a numerical dwell value of `3'. In this case the NC data output is as follows: CYCLE/DRILL, 25.000000, 500.000000, MMPM, 5.000000, DWELL, 3 The PP word table is updated with your syntaxes when you save the file.



NC Documentation This task shows you how to generate customized NC documentation. You will have to customize a VBScript macro file according to the document that you want to generate. You can use the following scripting languages, depending on the platform you are running on: BasicScript 2.2 SDK for UNIX (BasicScript is a registered trademark of Summit Software Company) VBScript, short for Visual Basic Scripting Edition, for Windows NT (Visual Basic is a registered trademark of Microsoft Corporation). Users on NT machines must have Windows Scripting Host installed. 1.



Open a sample delivered with the product from \Startup\Manufacturing\Documentation.



2.



Open the document delivered with the product in \Startup\Manufacturing\Documentation\NCDocumentationReadMe.htm.



3. 4.



This document describes the interfaces to help you to produce NC manufacturing documentation. Modify the sample according to the type of document you want. Generate the documentation as described in Generate NC Documentation.



Material Simulation Settings This task shows you how to customize settings for material removal simulation. 1. Select the Photo Settings icon



in the Material Removal Simulation Photo mode section of the Tool Path



Replay dialog box. The Settings dialog box appears that allows you to set options for the Photo mode. In the Faults tab you can customize: the colors in which the faults on the workpiece will be displayed after a machined part/design part comparison. the appearance of the fault indicator bounding box. In the General tab you can customize: the colors of the tools used for machining the machining accuracy the size of the workpiece scooped out. 2. In the Faults tab, select the desired colors to be displayed for machining that is within tolerance and for tool clashes.



3. For a particular type of fault, select the desired tolerance range (for example, Tol and Tol X 2) from the combo box and select its color representation in the adjacent combo box. Tol represents the tolerance value that you specified in the Material Removal Simulation - Errors dialog box.



4. In the Indicator section, select: the Solid button to display a transparent cuboid Indicator bounding box. You can also vary the amount of transparency. the Wireframe button to display a wireframe Indicator bounding box. The color of the bounding box may be modified to suit the workpiece color to ensure adequate visibility. These colors will be reflected on the workpiece wherever the tools have been used to cut material on the workpiece.



5. In the General tab, if the machining resolution is changed from coarse to fine, machining accuracy improves and results in a very detailed machining. However, a "fine" resolution results in more memory and time being consumed for machining.



The Close-up options are not used in this version.



6. Click OK to quit Material Removal Settings and return to the Replay dialog box.



Reference Information This section provides essential reference information on the following topics. Tools NC Macros PP Tables and PP Word Syntaxes APT Formats



Tools All supported tool types as well as their characteristic attributes are presented in this section. These attributes are particularly useful for tasks such as Building a catalog of tools.



Face Mill The MFG_NAME_BAS attribute for this tool is MfgFaceMillTool Symbols and corresponding geometry attributes used in this illustration are: MFG_NOMINAL_DIAM: D MFG_OUTSIDE_DIAM: Da MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CUT_LENGTH: lc MFG_CORNER_RAD: Rc MFG_BODY_DIAM: Db MFG_CUT_ANGLE: Kr



End Mill The MFG_NAME_BAS attribute for this tool is MfgEndMillTool Symbols and corresponding geometry attributes used in this illustration are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CUT_LENGTH: lc MFG_CORNER_RAD: Rc MFG_BODY_DIAM: Db



Center Drill The MFG_NAME_BAS attribute for this tool is MfgCenterDrillTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_LENGTH: lc MFG_CUT_ANGLE: a1 MFG_TAPER_ANGLE: a2



Spot Drill The MFG_NAME_BAS attribute for this tool is MfgSpotDrillTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_ANGLE: a



Drill The MFG_NAME_BAS attribute for this tool is MfgDrillTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_LENGTH: lc MFG_CUT_ANGLE: a MFG_TL_TIP_LGTH: ld



Countersink The MFG_NAME_BAS attribute for this tool is MfgCountersinkTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OUTSIDE_DIAM: Da MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_LENGTH: lc MFG_CUT_ANGLE: a MFG_ENTRY_DIAM: d



Reamer



The MFG_NAME_BAS attribute for this tool is MfgReamerTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_LENGTH: lc MFG_ENTRY_DIAM: d MFG_TL_TIP_LGTH: ld



Boring Bar The MFG_NAME_BAS attribute for this tool is MfgBoringBarTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_LENGTH: lc MFG_CUT_ANGLE: a MFG_NON_CUT_DIAM: dn MFG_TIP_LENGTH: lt MFG_TIP_ANGLE: e MFG_TIP_RADIUS: Re MFG_TOOL_ANGLE: b MFG_TL_TIP_LGTH: ld



Tap The MFG_NAME_BAS attribute for this tool is MfgTapTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_BODY_DIAM: Db MFG_CUT_LENGTH: lc MFG_ENTRY_DIAM: d MFG_TL_TIP_LGTH: ld



T-Slotter The MFG_NAME_BAS attribute for this tool is MfgTSlotterTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CORNER_RAD: Rc MFG_BODY_DIAM: Db MFG_CORNER_RAD_2: Rc2



Multi-Diameter Drill The MFG_NAME_BAS attribute for this tool is MfgMultiDiamDrillTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CUT_LENGTH: lc MFG_BODY_DIAM: Db MFG_CUT_ANGLE: a1 MFG_TAPER_ANGLE: a3 MFG_TL_TIP_LGTH: ld MFG_LENGTH_1: l1 MFG_LENGTH_2: l2 MFG_ANGLE_2: a2 MFG_CHAMFR_DIAM1: Dc MFG_CHAMFR_DIAM2: Dc2



Two Sides Chamfering Tool The MFG_NAME_BAS attribute for this tool is MfgTwoSidesChamferingTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CUT_LENGTH: lc MFG_BODY_DIAM: Db MFG_CUT_ANGLE: a1 MFG_TL_TIP_LGTH: ld MFG_ENTRY_DIAM: d MFG_ANGLE_2: a2



Boring and Chamfering Tool The MFG_NAME_BAS attribute for this tool is MfgBoringAndChamferingTool Symbols and corresponding geometry attributes used in this figure are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CUT_LENGTH: lc MFG_CORNER_RAD: Rc MFG_BODY_DIAM: Db MFG_LENGTH_1: l1 MFG_CHAMFR_DIAM1: Dc MFG_TAPER_ANGLE: a



Conical Mill The MFG_NAME_BAS attribute for this tool is MfgConicalMillTool Symbols and corresponding geometry attributes used in this illustration are: MFG_NOMINAL_DIAM: D MFG_OVERALL_LGTH: L MFG_LENGTH: l MFG_CUT_LENGTH: lc MFG_CORNER_RAD: Rc MFG_BODY_DIAM: Db MFG_ENTRY_DIAM: d MFG_CUT_ANGLE: a



NC Macros CATIA NC Macros in Machining Operations The following table shows which macro types you can define in the various types of machining operation. Macros are optional but are very useful for providing approach and retract transition paths in your operations. Operation Pocketing Contouring Facing Point to Point Axial Machining Circular Milling



Return Approach Retract Linking on Same Level Yes Yes Yes Yes Yes Yes



Yes Yes Yes Yes Yes Yes



Yes Yes Yes No Yes No



Yes Yes Yes No No Yes



Return between Levels Yes Yes Yes No No Yes



Return to Finish Clearance Pass Yes Yes Yes No No No



Yes Yes Yes No No No



Approach Macro An Approach macro is used to approach the operation start point.



Retract Macro A Retract macro is used to retract from the operation end point.



Linking Macro A Linking macro may used in several cases, for example: to avoid islands in Pocketing operations to link two non consecutive paths to access finish and spring passes in Pocketing and Contouring operations to link points of a pattern in an axial machining operation. You could define a Linking macro to do the following: 1. Retract along the tool axis at machining or finishing feedrate up to a safety plane defined by the top plane plus an approach clearance. 2. Approach next path along the tool axis with approach feedrate.



3. The clearance motion between the retract and approach is along a line in the safety plane at rapid feedrate.



Return on Same Level Macro A Return on Same Level macro is used in a level to link two consecutive paths of a multi-path operation. For example, you could define a Return on Same Level macro on a Profile Contouring operation in One Way mode to do the following : 1. Retract along the tool axis at machining feedrate up to a safety plane defined by the top plane plus an approach clearance. 2. Approach next path along the tool axis with approach feedrate. 3. The clearance motion between the retract and approach is along a line in the safety plane at rapid feedrate. Note that no Return on Same Level macro is needed on a Profile Contouring operation in Zig Zag mode. The motion between two paths is done at machining feedrate by following the profile of the boundary.



Return between Levels Macro A Return between Levels macro is used in a multi-level machining operation to go to the next level. You could define a Return between Levels macro to do the following: 1. Retract along the tool axis at machining feedrate up to a safety plane defined by the top plane plus an approach clearance. 2. Approach the next level along the tool axis at approach feedrate. 3. The clearance motion between the retract and approach is along a line in the safety plane at rapid feedrate.



Return to Finish Pass Macro A Return to Finish Pass macro is used in a machining operation to go to the finish pass. For example, you could define a Return to Finish Pass macro to do the following: 1. Retract along the tool axis at machining feedrate up to a safety plane defined by the top plane plus an approach clearance. 2. Approach the finish pass level along the tool axis at approach feedrate. 3. The clearance motion between the retract and approach is along a line in the safety plane at rapid feedrate.



Clearance Macro A Clearance macro can be used in a machining operation to avoid a fixture, for example. You could define a Clearance macro to do the following: 1. Retract along the tool axis at machining feedrate up to a safety plane. 2. Approach the finish pass level along the tool axis at approach feedrate. 3. The clearance motion between the retract and approach is along a line in the safety plane at rapid feedrate.



PP Tables and PP Word Syntaxes PP Word Tables You can create and manage Post-Processor word tables with CATIA NC Manufacturing products. A sample PP word table is delivered with the product, and can be used as a basis for creating user-defined tables. A PP word table is stored in a unique text file with suffix pptable. A PP word table can be defined for a specific machine tool and used in CATIA NC applications. You can also define the general syntaxes of post-processor words. These syntaxes will be proposed when you want to create a PP instruction. A PP word table comprises: major words without parameters major words with a text major words with parameters minor words word syntaxes. You can define for a given machine tool: syntaxes associated to particular NC commands sequences of PP word syntaxes associated to particular NC instructions. The CATIA NC Manufacturing product will resolve the parameters of these syntaxes and syntax sequences and generate the corresponding statements in the APT output.



NC Commands You can define for a given machine tool (i.e. post-processor) PP word syntaxes associated to particular NC commands. An NC command is a machine function such as feedrate declaration (NC_FEEDRATE) or spindle activation (NC_SPINDLE_START). A syntax comprises a major word and one or more syntax elements such as minor words, numerical values, lists and parameters. A syntax that includes lists or parameters is a parameterized syntax (see example below): *START_NC_COMMAND LOADTL/%MFG_TL_NUMBER,%MFG_TL_COMP *END



NC_COMPENSATION



Note that the `&' character indicates a list and the `%' character indicates a parameter. A list has a finite number of values. You can define only one syntax for each NC command. For an example of how to define syntaxes in NC commands, please see PP Word Syntaxes in the Customizing section of this guide.



Syntaxes of NC Commands NC command syntaxes that are supported in the current version are as follows. NC_DELAY MFG_DELAY_UNIT: list with two values defining the delay units. First value: delay expressed in number of revolutions. REV is the default value. Second value: delay expressed in seconds. A blank string (represented by 8 underscore characters) is the default value. When the statement is generated



by the application this string is ignored. MFG_DELAY_VALUE: numerical value of the delay. NC_FEEDRATE MFG_FEED_UNIT: list with two values defining the feedrate units. First value: feedrate expressed in model units per minute. MMPM is the default value. Second value: feedrate expressed in model units per revolution. MMPR is the default value. MFG_FEED_VALUE: numerical value of the feedrate. NC_SPINDLE_ON This syntax of this NC command is SPINDL/ON and cannot be parameterized. NC_SPINDLE_START or NC_SPINDLE MFG_SPNDL_UNIT: list with two values defining the spindle rotation units. First value: spindle rotation expressed in revolutions per minute. RPM is the default value. Second value: spindle rotation expressed in surface meters per minute. SMM is the default value. MFG_SPNDL_WAY: list with two values defining the direction of rotation of the spindle. First value: spindle rotation processed clockwise. CLW is the default value. Second value: spindle rotation processed counter-clockwise. CCLW is the default value. MFG_SPNDL_SPEED: numerical value of the spindle speed. MFG_SPNDL_DIAMTR: numerical value of the spindle diameter. NC_SPINDLE_STOP MFG_SPNDL_STOP: list with two values defining the action applied to the spindle. First value: de-activation of the spindle. OFF is the default value. Second value: spindle locked in an indexed position. LOCK is the default value. MFG_CMP_ANGLE: value of the indexation angle. NC_SPINDLE_LOCK This syntax of this NC command is SPINDL/LOCK and cannot be parameterized. NC_SPINDLE_OFF This syntax of this NC command is SPINDL/OFF and cannot be parameterized. NC_COMPENSATION MFG_TL_COMP: value of the tool compensation length MFG_TL_COMP_RAD: value of the tool compensation radius MFG_TL_NUMBER: tool number associated to the compensation. MFG_TL_NAME: name of tool associated to the compensation NC_COMMENT MFG_MO_COMMENT: comment defined on machining operation. NC_CUTCOM_ON This syntax of this NC command is CUTCOM/ON and cannot be parameterized. NC_CUTCOM_OFF This syntax of this NC command is CUTCOM/OFF and cannot be parameterized. NC_CUTCOM_LEFT This syntax of this NC command is CUTCOM/LEFT and cannot be parameterized. NC_CUTCOM_RIGHT This syntax of this NC command is CUTCOM/RIGHT and cannot be parameterized. NC_MACHINING_AXIS This syntax of this NC command is as follows:



$$*CATIA0 $$ %MFG_NCAXIS_IDENTIFIER $$ %MFG_NCAXIS_X_VECX %MFG_NCAXIS_X_VECY %MFG_NCAXIS_X_VECZ %MFG_NCAXIS_X_ORIG $$ %MFG_NCAXIS_Y_VECX %MFG_NCAXIS_Y_VECY %MFG_NCAXIS_Y_VECZ %MFG_NCAXIS_Y_ORIG $$ %MFG_NCAXIS_Z_VECX %MFG_NCAXIS_Z_VECY %MFG_NCAXIS_Z_VECZ %MFG_NCAXIS_Z_ORIG



The parameters are as follows: MFG_NCAXIS_IDENTIFIER: machining axis identifier MFG_NCAXIS_X_ORIG, MFG_NCAXIS_Y_ORIG, MFG_NCAXIS_Z_ORIG: coordinates of the machining axis origin MFG_NCAXIS_X_VECX, MFG_NCAXIS_Y_VECX, MFG_NCAXIS_Z_VECX: components of the x-axis MFG_NCAXIS_X_VECY, MFG_NCAXIS_Y_VECY, MFG_NCAXIS_Z_VECY: components of the y-axis MFG_NCAXIS_X_VECZ, MFG_NCAXIS_Y_VECZ, MFG_NCAXIS_Z_VECZ: components of the z-axis. NC_MULTAX_ON This syntax of this NC command is MULTAX and cannot be parameterized. NC_MULTAX_OFF This syntax of this NC command is MULTAX/OFF and cannot be parameterized.



NC Instructions You can define for a given machine tool (i.e post-processor) sequences of PP word syntaxes associated to particular NC instructions. NC instructions are either axial machining operations or auxiliary commands. A syntax comprises a major word and one or more syntax elements such as minor words, numerical values and standard parameters. A set of standard parameters is associated to each NC instruction. Parameters may be combined in arithmetical expressions. A syntax that includes parameters is a parameterized syntax (see examples below): *START_NC_INSTRUCTION NC_TOOL_CHANGE *START_SEQUENCE TOOLNO/%MFG_TOOL_NUMBER,%MFG_NOMINAL_DIAM TPRINT/%MFG_TOOL_NAME LOADTL/%MFG_TOOL_NUMBER *END *END *START_NC_INSTRUCTION *START_SEQUENCE CYCLE/TAP,%MFG_TOTAL_DEPTH,%MFG_CLEAR_TIP *END *END



NC_TAPPING



Note that the `%' character indicates a parameter. You can define one or more syntax sequences for each NC instruction. For an example of how to define syntax sequences in NC Instructions, please see PP Word Syntaxes in the Customizing section of this guide.



Standard Parameters for Auxiliary Command Type NC Instructions These parameters include data defined on the corresponding entity or computed parameters which are calculated according to an application method. NC_START_MACRO MFG_IDENTIFIER: Part Operation identifier



MFG_PROGRAM_NAME: Part Operation Program name MFG_MACHINE_NAME: Machine name NC_END_MACRO MFG_IDENTIFIER: Part Operation identifier MFG_MACHINE_NAME: Machine name NC_TABLE_ROTATION MFG_TYPE_OF_ROT: Rotation type (absolute angle in this version) MFG_DIR_OF_ROT: Rotation direction (clockwise or counterclockwise) MFG_AMOUNT_ROT: Angle of rotation about the axis of rotation MFG_AXIS_OF_ROT: Axis of rotation on machine table. MFG_ABC_AXIS: Axis of rotation on machine table to get Minor word AAXIS, BAXIS or CAXIS. NC_TOOL_CHANGE Please note that in the following description 'tool assembly' means 'tool' or 'cutter' for the current version. MFG_TL_ASMBLY_ID: Tool assembly identifier MFG_TL_SET_LGTH: Tool set length MFG_NOMINAL_DIAM: Nominal diameter of the tool MFG_TOOL_COMMENT: Comment associated with the tool MFG_TOOL_NUMBER: Tool assembly number MFG_ASS_COMMENT: Comment associated with the tool assembly MFG_WEIGHT_SNTX: Tool weight syntax MFG_COOLNT_SNTX: Coolant supply syntax MFG_TOOTH_DES: Tooth description MFG_DIAMETER_2: Diameter 2 of the tool assembly MFG_MAX_MIL_TIME: Tool life (in time units) MFG_MAX_MIL_LGTH: Tool life (in length units) MFG_CORNER_RAD: Tool corner radius MFG_CUT_ANGLE: Tool cutting angle MFG_LENGTH: Length of active part of the tool MFG_TL_TIP_LGTH: Tool tip length MFG_CUT_LENGTH: Tool cutting length MFG_NB_OF_FLUTES: Number of teeth MFG_TOOL_NAME: Tool name MFG_FEED_MACH: Machining feedrate MFG_SPNDL_MACH: Machining spindle speed MFG_TL_SET_X: Tool set length in x direction. MFG_TL_SET_Y: Tool set length in y direction. MFG_FEED_UNIT: Computed feedrate unit MFG_SPNDL_UNIT: Computed spindle speed unit MFG_WAY_OF_ROT: Computed rotation direction of tool (RIGHTHAND or LEFTHAND) MFG_TOOL_ASS_POW: Computed tool assembly power type (the value is MILL) MFG_TOOL_COMP: Computed tool compensation MFG_TOOL_COMP_2: Second computed tool compensation. NC_ORIGIN MFG_NCAXIS_X_ORIG, MFG_NCAXIS_Y_ORIG, MFG_NCAXIS_Z_ORIG: coordinates of the origin MFG_ORIGIN_NUMBER: origin number MFG_ORIGIN_GROUP: origin group.



Standard Parameters for Axial Machining Operation Type NC Instructions For axial machining operations the standard parameters are either: tool guiding parameters or machinability data defined on the corresponding machining operation geometrical data defined on the corresponding operation parameters that are calculated according to an application method.



Axial machining operation type NC Instructions are as follows. NC_TAPPING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance NC_THREAD_WITHOUT_TAP_HEAD Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance NC_REVERSE_THREADING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed



MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance NC_BORING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_BORING_SPINDLE_STOP Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows:



MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_LIFT_MODE: Shift mode MFG_XOFF: Shift along X MFG_YOFF: Shift along Y MFG_ZOFF: Shift along Z MFG_LIFT_ANGLE: Shift angle MFG_LIFT_DIST: Shift distance MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay MFG_CMP_OFFSET: Computed offset MFG_CMP_ANGLE: Computed angle NC_BACK_BORING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_LIFT_MODE: Shift mode MFG_XOFF: Shift along X MFG_YOFF: Shift along Y MFG_ZOFF: Shift along Z MFG_LIFT_ANGLE: Shift angle MFG_LIFT_DIST: Shift distance MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay MFG_CMP_OFFSET: Computed offset MFG_CMP_ANGLE: Computed angle.



NC_BORING_AND_CHAMFERING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_CLEAR_TIP_2: Second approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_CHAMFER_VAL: Chamfer value MFG_TL_COMP: Tool compensation number MFG_TL_COMP_2: Second tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation MFG_TOOL_COMP_2: Second tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_TWO_SIDES_CHAMFERING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_CLEAR_TIP_2: Second approach clearance MFG_DEPTH_MODE: Depth mode MFG_TL_COMP: Tool compensation number MFG_TL_COMP_2: Second tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation MFG_TOOL_COMP_2: Second tool compensation.



Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_COUNTERBORING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_COUNTERSINKING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows:



MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_DRILLING_DWELL_DELAY Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_BREAK_CHIPS Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_AXIAL_DEPTH: Axial depth MFG_OFFSET_RET: Retract offset MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds)



MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay MFG_EFFCT_DEPTH: Effective depth NC_DEEPHOLE Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_AXIAL_DEPTH: Axial depth MFG_OFFSET_RET: Retract offset MFG_DEPTH_DEC: Decrement limit MFG_DEPTH_LIM: Decrement rate MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay MFG_EFFCT_DEPTH: Effective depth NC_REAMING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number



MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_SPOT_DRILLING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_DRILLING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_BREAKTHROUGH: Breakthrough distance



MFG_TL_COMP: Tool compensation number MFG_PLUNGE_MODE: Plunge mode MFG_PLUNGE_TIP: Plunge tip distance MFG_PLUNGE_OFFST: Plunge tip offset MFG_PLUNGE_DIAMETER: Plunge diameter MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance NC_T_SLOTTING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters are as follows: MFG_CLEAR_TIP: Approach clearance MFG_DEPTH_MODE: Depth mode MFG_TL_COMP: Tool compensation number MFG_DWELL_MODE: Dwell mode MFG_DWELL_REVOL: Dwell delay in revolutions MFG_DWELL_TIME: Dwell delay in time units (seconds) MFG_TOOL_COMP: Tool compensation. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth MFG_PLUNGE_DIST: Plunge distance MFG_CMP_DWL_TIME: Computed dwell delay NC_CIRCULAR_MILLING Feeds and Speeds parameters are as follows: MFG_FEED_PLUNGE_MODE: Plunge feedrate mode MFG_FEED_PLUNGE_VALUE: Plunge feedrate MFG_FEED_MACH_VALUE: Machining feedrate MFG_SPINDLE_MACH_VALUE: Machining spindle speed MFG_FEED_RETRACT_MODE: Retract feedrate mode MFG_FEED_RETRACT_VALUE: Retract feedrate Machining Strategy parameters include: MFG_CLEAR_TIP: Approach clearance MFG_TL_COMP: Tool compensation number MFG_TOOL_COMP: Tool compensation MFG_RADIAL_STEP: Distance between paths MFG_RADIAL_NB: Number of paths MFG_AXIAL_STRAT: Axial mode MFG_AXIAL_DEPTH: Maximum depth of cut MFG_AXIAL_NUMBER: Number of levels MFG_SEQUENCING_STRAT: Sequencing mode MFG_TOLER_MACH: Machining tolerance MFG_DIR_CUT: Direction of cut



MFG_OVERHANG: Percentage overlap MFG_DRAFT_ANGLE: Automatic draft angle. Computed parameters are as follows: MFG_DETAIL_DEPTH: Detail depth MFG_TOTAL_DEPTH:Total depth.



APT Formats APT Source Output This section describes formats used to write CATIA data on APT source files. Blank characters used for presentation comfort on file are not mentioned. Example of format: 'AUTOPS' 'INDIRV/',F11.5,',',F11.5,',',F11.5' 'TLON,GOFWD/ (CIRCLE/',F13.5,',',F13.5,',',F13.5,',$',T73,'CIR',I5 F13.5,'),ON,2,INTOF,$' '(LINE/',F13.5,',',F13.5,',',F13.5,',$' F13.5,',',F13.5,',',F13.5,')'



Example of Generated APT Source AUTOPS INDIRV/ 0.00000, -1.00000, 0.00000 TLON,GOFWD/ (CIRCLE/ 0.00000, 0.00000, 0.00000,$ CIR 1 50.00000),ON,2,INTOF,$ (LINE/ 0.00000, 0.00000, 0.00000,$ 50.00000, 0.00000, 0.00000)



For each tool movement (GOTO, GODLTA, or CIRCLE, for example), the application generates specific information on the corresponding line to indicate the total number of points or circles generated. For example, PT 22 or CIR 1. This information is written starting from column 73 in the APT source file.



Syntax of APT Instructions Generated by the Application General Information '$$',70('=') '$$',6X,'GENERATED ON ',A28,' AT ',A8



Operation Numbers



start of execution (date, time)



'PPRINT OPERATION NUMBER: ',I4 '$$ OPERATION NUMBER: ',I4



operation order number in part operation



PP or APT Word Instruction A80



PP instruction string



NC Axis Components '$$*CATIA0' '$$ ',A70



NC axis identifier(may be blank if table rotation operation).



'$$ ',4(F11.5,2X) '$$ ',4(F11.5,2X) '$$ ',4(F11.5,2X)



NC axis matrix definition in absolute axis (*axis1)



Model, Part Operation and Working Mode 'PPRINT MACHINE = ',A60



machine name (sub-string)



'PPRINT MODEL = ',A60



model name (sub-string)



'PPRINT PART OP = ',A60



part operation name (sub-string)



'TLAXIS/'F9.6,2(',',F9.6) system.



tool axis components expressed in machining axis



Starting Point Operation 'GOTO/',F11.5,2(',',F11.5),T73,'PT ',I5



tool tip coordinates, point number



'FROM/',F11.5,2(',',F11.5),T73,'PT ',I5



tool tip coordinates, point number



Tool Information 'PPRINT TOOL = ',A60



tool name (sub-string)



'CUTTER/',4(F10.6,','),F10.6,',$' F10.6,',',F10.6 cutter diameter, corner radius, distance center corner to tool axis, corner radius, 0.0 beta angle, height



Option Values 'INTOL /',F11.5



machining tolerance



'OUTTOL/',F11.5



0.0



Feedrate Values 'FEDRAT/',F10.4



feedrate values



'RAPID'



Linear Tool Motion 'GOTO/',F11.5,2(',',F11.5),T73,'PT ',I5



tool tip coordinates, point number



'GODLTA/',F11.5,2(',',F11.5),T73,'PT ',I5 number



tool tip incremental move, point



Circular Tool Motion - CIRCLE/ 'AUTOPS' 'INDIRV/',F11.5,',',F11.5,',',F11.5' start pt



components of circle tangent at arc



'TLON,GOFWD/ (CIRCLE/',F13.5,',',F13.5,',',F13.5,',$',T73,'CIR',I5 center coords, circle number



circle



EITHER: F13.5,'),ON,(LINE/',F13.5,',',F13.5,',',F13.5,',$'



radius, circle center coords



OR: F13.5,'),ON,2,INTOF,$'



radius,



'(LINE/',F13.5,',',F13.5,',',F13.5,',$' F13.5,',',F13.5,',',F13.5,')'



circle center coords



arc end point coords



Circular Tool Motion - CYLNDR/ 'PSIS/(PLANE/(POINT/',F11.5,2(',',F11.5),'),PERPTO,$' '(VECTOR/',2(F9.6,','),F9.6,'))' '(INDIRV/',F11.5,',',F11.5,',',F11.5) start point



tool tip coordinates



circle axis components components of circle tangent at arc



'TLON,GOFWD/(CYLNDR/',2(F11.5,','),F11.5,',$',T73,'CIR',I5 coordinates, circle number EITHER: 3(F11.5,','),F11.5,'),ON,$' OR:



circle axis components, radius



circle center



3(F11.5,','),F11.5,'),ON,2,INTOF,$'



circle axis components, radius



'(PLANE/PERPTO,$') '(PLANE/(POINT/',F11.5,2(',',F11.5),'),PERPTO,$'



circle center coordinates



'(VECTOR/',2(F9.6,','),F9.6,')),$')



circle axis components



'(POINT/',2(F11.5,','),F11.5,'),$')



circle center coordinates



'(POINT/',2(F11.5,','),F11.5,'))'



arc end point coordinates



Glossary A approach macro auxiliary command axial machining operation



Motion defined for approaching the operation start point A control function such as tool change or machine table rotation. These commands may be interpreted by a specific post-processor. Operation in which machining is done along a single axis and is mainly intended for hole making (drilling, counter boring, and so on).



B back and forth Machining in which motion is done alternately in one direction then the other. Compare with one way. bottom plane A planar geometric element that represents the bottom surface of an area to machine. It is normal to the tool axis.



C clearance Motion that involves retracting to a safety plane, a linear trajectory in that plane macro and then plunging from that plane. climb milling Milling in which the advancing tool rotates down into the material. Chips of cut material tend to be thrown behind the tool, which results to give good surface finish. Compare with conventional milling. conventional Milling in which the advancing tool rotates up into the material. Chips of cut milling material tend to be carried around with the tool, which often impairs good surface finish. Compare with climb milling.



D DPM



Digital Process for Manufacturing.



E extension type



Defines the end type of a hole as being through hole or blind.



F Facing operation Fault feedrate fixture



A surfacing operation in which material is removed in one cut or several axial cuts of equal depth according to a pre-defined machining strategy. Boundaries of the planar area to be machined are soft. Types of faults in material removal simulation are gouge, undercut, and tool clash. Rate at which a cutter advances into a work piece. Measured in linear or angular units (mm/min or mm/rev, for example). Elements used to secure or support the workpiece on a machine.



G gouge



Area where the tool has removed too much material from the workpiece.



H hard



A geometric element (such as a boundary or a bottom face) that the tool cannot pass beyond.



I inward helical Machining in which motion starts from a point inside the domain to machine and follows paths parallel to the domain boundary towards the centre of the domain. Compare with outward helical.



L linking motion Motion that involves retracting to a safety plane, a linear trajectory in that plane and then plunging from that plane. M machine rotation machining axis system machining feature machining operation



An auxiliary command in the program that corresponds to a rotation of the machine table. Reference axis system in which coordinates of points of the tool path are given. A feature instance representing a volume of material to be removed, a machining axis, tolerances, and other technological attributes. These features may be hole type or milling type. Contains all the necessary information for machining a part of the workpiece using a single tool.



machining The maximum allowed difference between the theoretical and computed tool tolerance path. manufacturing Defines the sequence of part operations necessary for the complete process manufacture of a part. manufacturing Describes the processing order of the NC entities that are taken into account program for tool path computation: machining operations, auxiliary commands and PP instructions. manufacturing The set of machining features defined in the part operation. view multi-level Milling operation (such as Pocketing or Profile Contouring) that is done in a operation series of axial cuts.



O offset



one way outward helical



Specifies a virtual displacement of a reference geometric element in an operation (such as the offset on the bottom plane of a pocket, for example). Compare with thickness. Machining in which motion is always done in the same direction. Compare with zig zag or back and forth. Machining in which motion starts from a point inside the domain to machine and follows paths parallel to the domain boundary away from the centre of the domain. Compare with inward helical.



P part operation Links all the operations necessary for machining a part based on a unique part registration on a machine. The part operation links these operations with the associated fixture and set-up entities. pocket An area to be machined that is defined by a closed boundary and a bottom plane. The pocket definition may also include a top plane and one or more islands. Pocketing A machining operation in which material is removed from a pocket in one cut or operation several axial cuts of equal depth according to a pre-defined machining strategy. The toolpath style is either inward helical or outward helical. Boundaries of the pocket are hard. Point to Point A milling operation in which the tool moves in straight line segments between operation user-defined points. PP instruction Instructions that control certain functions that are auxiliary to the tool-part relationship. They may be interpreted by a specific post processor. PPR Process Product Resources.



Profile Contouring operation



A milling operation in which the tool follows a guide curve and possibly other guide elements while respecting user-defined geometric limitations and machining strategy parameters.



R retract macro Motion defined for retracting from the operation end point return macro Motion for linking between paths or between levels. It involves retracting to a safety plane, a linear trajectory in that plane and then plunging from that plane.



S safety plane



A plane normal to the tool axis in which the tool tip can move or remain a clearance distance away from the workpiece, fixture or machine.



set up



Describes how the part, stock and fixture are positioned on the machine.



soft



A geometric element (such as a boundary or a bottom face) that the tool can pass beyond. spindle speed The angular speed of the machine spindle. Measured in linear or angular units (m/min or rev/min, for example). stock Workpiece prior to machining by the operations of a part operation.



T thickness



tool axis



Specifies a thickness of material to be removed by machining. Compare with offset. A planar geometric element that represents the top surface of an area to machine. It is always normal to the associated tool's rotational axis. Center line of the cutter.



tool change



An auxiliary command in the program that corresponds to a change of tool.



tool clash



Area where the tool collided with the workpiece during a rapid move.



tool path



The path that the center of the tool tip follows during a machining operation.



total depth



The total depth including breakthrough distance that is machined in a hole making operation.



top plane



U undercut



Area where the tool has left material behind on the workpiece.



Z zig zag



Machining in which motion is done alternately in one direction then the other. Compare with one way.



Index A Activate command analyze geometry approach macro APT Import command Auxiliary operations axial machining operations



B Back Boring operation Boring and chamfering tool Boring and Chamfering operation Boring bar Boring operation Boring Spindle Stop operation



C Center drill Chamfering Two Sides operation Circular Milling operation clearance macro climb milling Conical mill conventional milling Counterboring operation Countersink Countersinking operation



D Deactivate command Delete Generated Tool Changes command Delete Generated Machine Rotations command Drill Drilling Break Chips operation Drilling Deephole operation Drilling Dwell Delay operation Drilling operation



E Edit Parameters dialog box End mill entry distance exit distance



F Face mill Facing operation



G Generate Tool Changes command Generate Machine Rotations command



H hard geometric element



J jump distance



M machine rotation machining axis machining feature machining operation machining pattern machining tolerance manufacturing program manufacturing process milling operations Multi-diameter drill



N NC command NC_COMMENT NC_COMPENSATION NC_CUTCOM_LEFT NC_CUTCOM_OFF NC_CUTCOM_ON NC_CUTCOM_RIGHT NC_DELAY NC_FEEDRATE NC_MACHINING_AXIS NC_MULTAX_ON NC_MULTAX_OFF NC_SPINDLE NC_SPINDLE_LOCK NC_SPINDLE_OFF NC_SPINDLE_ON NC_SPINDLE_START



NC_SPINDLE_STOP NC instruction (axial machining type) NC_BACK_BORING NC_BORING NC_BORING_SPINDLE_STOP NC_BORING_AND_CHAMFERING NC_BREAK_CHIPS NC_CIRCULAR_MILLING NC_COUNTERBORING NC_COUNTERSINKING NC_DEEPHOLE NC_DRILLING NC_DRILLING_DWELL_DELAY NC_REAMING NC_REVERSE_THREADING NC_SPOT_DRILLING NC_T_SLOTTING NC_TAPPING NC_THREAD_WITHOUT_TAP_HEAD NC_TWO_SIDES_CHAMFERING NC instruction (auxiliary command type) NC_END_MACRO NC_ORIGIN NC_START_MACRO NC_TABLE_ROTATION NC_TOOL_CHANGE



O origin



P part operation pattern Pocketing operation Closed pockets Open pockets Preview command Profile Contouring operation Between a curve and surfaces Between two curves Between two planes Point to Point operation PP instruction PP word table



R Reamer Reaming operation retract macro return macro return between levels macro return on same level macro return to finish pass macro Reverse Threading operation



S soft geometric element Spot drill Spot Drilling operation



T Tap Tapping operation Thread without Tap Head operation T-slotter T-slotting operation tool Boring and chamfering tool Boring bar Conical mill Center drill Countersink compensation create edit Drill End mill Face mill Multi-diameter drill Reamer Spot drill Tap T-slotter Two sides chamfering tool Two sides chamfering tool tool change Tool path replay tools catalog



U undercut
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